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About This Document

This guide provides a comprehensive, step-by-step configuration process for setting up and preparing your
organization for the Authentication Methods supported on the VOS.

Authentication serves as a mechanism for verifying users' identities to ensure that only authorised
individuals gain access to applications. Multiple authentication methods can be configured to authenticate
end users, including the use of a local database, a Lightweight Directory Access Protocol (LDAP) server,
Security Assertion Markup Language (SAML), and Kerberos. This document outlines the procedures for
configuring an Open-LDAP server, Active Directory (AD) LDAP server, SAML, device and user certificates for
end-user authentication. Additionally, administrators can configure either user-based or group-based
policies to determine whether access is permitted or denied.

Document Information

Configuring Authentication Profiles on the SSE Gateway

Versa Professional Services

Version V1.0

Disclaimer

Information contained in this document regarding Versa Networks (the Company) is considered
proprietary.

Before you begin

Before you proceed with the steps outlined in this document, please ensure you've met the following
prerequisites.

e The provider administrator must complete your tenant configuration. If you haven't received this
information, please contact your Managed Service Provider or Account Manager for assistance.

e You have the Enterprise Administrator (Tenant Admin) credentials for the Versa SASE portal, also
called the Concerto User Interface.
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LDAP Active-Directory

LDAP is a client-server protocol that enables network devices to access directory services storing attribute-based in-
formation, allowing for user authentication through querying a directory server. The SSE gateway queries the LDAP
server to validate the user, granting or denying access based on the authentication result. Users can be validated indi-
vidually or within groups, and the configuration involves specifying server details, SSL settings, and profiles.

Scenario
In most enterprise environments, user authentication is centralized through AD/LDAP servers in the data centre. In
cases of VSPA or VISA, users securely connect to the SSE gateways using the Versa SASE Client from remote locations,
branches, or corporate offices. Authentication requests from the SASE client are directed to the Versa Secure Access
Gateway, which communicates with AD/LDAP over IPSec tunnels to validate credentials and retrieve group or role at-

tributes for policy enforcement.

Upon successful authentication, users are granted secure access to resources hosted within data centres and to
SaaS/cloud applications such as Microsoft Teams, Skype, and Office 365. This configuration ensures consistent, iden-
tity-based access for both remote and on-premises users, thereby facilitating streamlined policy enforcement based

on identity enforcement.

Cloud
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Fublic Cloud or 5288 App NETWORKS
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Enterprise
Datacenter

Active Directory /
LDAP Server
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Remotle User Corporate Office

Navigate to User and Device Authentication Configuration

Go to: Configure > Security Service Edge > User and Device Authentication > Profiles then “+ Add”



WVERSA  ACME-ONE CONFIGURATION Cg')

ure SD-WAN

Real-Time Protection

/pe Description

Secure Access

No Data

Disgital Experience Monitoring (DEM)

TLS Decryption

Bandwidth Limits

Moenitor

Profiles and Connectors

Partner Integration

User and Device Authent\'cation] i

p—
<

Rules

Inventory

Select LDAP as Authentication Method then Click Get Started

Add User and Device Authentication Profile

America/Bogota ¥ (= | B English v o
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Administrator o
Service Provider Administrator

Publish (1)

Select Columns v

Tags Last Modified

Select which user / device authentication profile you would like to configure.

Q|
LoAP SAML RADIUS
LDAP s aclient-server protocol SAMLI: for
network device to access an LDAP server, which sothat they ices and Howis
ides directory servi ipth ions. SAML them to access a network, a device, or related
attribute-based information. browser-based single sign-on (SS0). services.
Versa Directory User Certificate Based Device Certificate Based
Certificat Certificate-based
With y S Y . . 3
of for s user y 3 ¥

ell as add individual users and
well as RS S0 thet rDApL: Initiates a request to the SASE cllent for users to

provide their certificates during client portal

Note: Only one Versa Directory authentication profile Sahiadiog sl gty ot

can be added.

From the Server Type dropdown, select Active Directory

initiates a request to the SASE client for users to
provide their certificates during client portal
registration and gateway connection.



Add LDAP Authentication Profile

User And Group Profile Reviaw & Submit

Server Type

Active Directory

PO

@ FQDN

) 1P Address

+Add Secondary Server

VPN Name *
ACME-ONE-Enterprise
Port*

369

Enable SSL

5L Mode

CACertificate

The following section explains all parameters for LDAP Authentication Profile configuration.

LDAP Authentication Profile — Parameters
Parameter Description Current Use Case
Server Type It indicates that the authentication source is Mi- active director
yp crosoft Active Directory or Open-LDAP. y
FQDN or IP | The Fully Qualified Domain Name (FQDN) or IP ad- 10.163.106.33 or ad-
Address dress of the AD/LDAP server. server.company.local
VPN Name Defines .whllch VPN _|nstanc.e or network segment this ACME-ONE-Enterprise
authentication profile applies to.
Port used for LDAP/AD communication.
Possible options:
Port 389: Default LDAP port & 389TCP
636: Default LDAPS (LDAP over SSL)
Enabled/Disabled: Determines if the connection be-
tween Versa and the AD server uses SSL/TLS for se-
curity. .
SSL Stat . o Disabled
atus If enabled, you must also specify the CA certificate sable
details (trusted CA/chain) that will be used for TLS
communication verification.
Bind Distinguished Name (DN): This is the "service cn=Administrator, cn=us-
account” that Versa will use to connect and query ers, dc=versa,dc=com
Bind DN the LDAP/AD directory. Bind DN allows Versa to au- cn = Common Name

Bind Password

thenticate itself to the AD server, enabling it to
search for users and groups.
The password for the Bind DN account.

dc = Domain Component

Service account password

Base DN

Base Distinguished Name (DN): This is the starting
point in the LDAP directory tree from which searches
will begin. It defines the organisational scope of the
LDAP search.

Example: cn=us-
ers,dc=versa,dc=com

Domain Name

The name of the AD domain.

versa.com

Search
Timeout (sec)

Maximum time (in seconds) Versa will wait for a re-
sponse from the LDAP server during a query.

30
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Cache Expiry How long (in minutes) user/group information re- 10
Time (mins) trieved from LDAP will be cached before refreshing.
Concurrent The maximum number of concurrent sessions al- 3
Logins lowed for the same user.
NOTE: Refer Appendix A to understand how to get the Base DN and Bind DN
Add LDAP Authentication Profile x
@

Server Type 1

Active Directory

Select either FQDN or IP Address *

© FOQDN

@ IPAddress 1016310633 2

+ Add Secandary Server
B E
4
o S

Next, complete the required fields: specify the Bind DN (Distinguished Name of the user account used to bind to the
LDAP/AD server), enter the Bind Password for that account, set the Base DN (the starting point in the directory tree
for LDAP searches), and provide the Domain Name. Once all values are filled in, click Next to proceed Next

Add LDAP Authentication Profile »
Settings User And Group Profile Review & Submit
ACME-ONE-Enterprise
Port™
39
Enable SSL
CA Certificate
Bind DN * Bind Password * Bind Timeout {sec)
‘o= Administratorcneusers.dc=acme-one.dc=com sensnsan o ®
BaseDN* Domain Name * Base Domain
enmusars de=acme-one decom acme-one.com
Search Timeout (sec) Cache Expiry Time (mins) Concurrent Logins.
£ ) 3

e T S |

Next, complete the required fields:

LDAP Object and User Attributes

Parameter Value / Default Description
Group Ob- rou Standard AD object class for security and distribution groups. Re-
ject Class group quired to identify groups in the directory.
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Group name Attribute that defines the display name of a group. Used by Versa to

Name match groups during policy evaluation.

Group Attribute that lists group memberships for a user object. Ensures
memberOf - .

Member Versa can apply policies based on AD group membership.

User Object User Standard AD object class for user accounts. Required for identifying

Class users in the directory.
userPrincipalName (recom- Attribute used for login. userPrincipalName (e.g., user@versanet-

User Name | mended) or sAMAccount- works.com) is modern and preferred. sAMAccountName is legacy
Name but still supported.

Password Attribute showing when a user’s password was last changed. Useful
pwdLastSet . o .

Last Set for enforcing password expiration policies.

Password Attribute defining the maximum password lifetime. Derived from the
maxPwdAge . .

Max Age AD domain password policy.

Refresh In- Determines how often Versa refreshes user and group information
21600 (default = 6 hours) from LDAP. Can be tuned based on the frequency of directory

terval (sec) changes

click Next to proceed.

Add LDAP Authentication Profile

Group Object Class*
froup

User Object Class *
user

Refresh Interval (seconds)

21800

Settings

Group Name *

name

User Name *

userPrincipalName

Password Last Set

pwdLastSet

Cancel Back

User And Group Profile

®

Review & Submit

Group Member *

Next, fill in the Name field with a descriptive reference, such as AD_Server ACME-ONE, and review all parameters to
ensure they are correctly configured.
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Add LDAP Authentication Profile %

o
s

sa At G e

Settings /4

Server Type active deectory
FODN o 1P Address 1014310433

VPN Name ACMEONEEnterprise
Pt £

59 810t Disstied

S mode

cacenifeare

FieName

[

nsued By

e

BindDN en=idricistrator raisars deszcme-one escom
Bird Passvond ——

B Timeout fsac) Y

BussOn musors o-scme onegencom
Do Nere: e crecom

Basa Domain

Search Timootfec) 0

Cache Expiry Time s} 0

Concurrent Logins s

Then Save.

AddLDAP Authentication Profile

Usae At G Bl R St
FODN oe P Address 1016310633

VP Name: ACMEONE Enterprse

Port 87

s anhe Disatied

S5 Mode.

CACefcate

Fike Nane:

s To

esued By

alidity

Bind DN armAINr o Crmgsers o= o do~Com
Bird Passward —

B Timeout s2c) o

BasaDN rmusers desacme-one descom

Domsin M acme-anecom

Base Domain

‘Search Timeout (sec) 2

‘Cache Expiry Time firs)

Concurrent Logins 3

Userand Group Profile  # Edit

Group Object s gon
Group Name name

Group Mt p——

s Object s e

User Mame: userPrincipalName.
Refresh Interval (seconds] 21600
[———— puLastict
Password Max Age: maxbuedige

Go to Publish.
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W VERSA ACME-ONE CONFIGURATION “? America/Bogota 7= | W Englsh ~ | (@

Pubiish (1)
1 User and Device Authentication Profile
v

User and Device Authentication Profies (1) + ndd £ Refresh Select Columns. v

Configure. Hame: Description g Last Modified

§i

> ADserver Acme Ot

Showing Lo dresuits 10 = Rowsper Page Gotopage 1+ 1

After creating an Authentication Profile, you need to publish it to take effect.

Verification
To verify that LDAP authentication is working, we can create a dummy Secure Access rule and check if the User or
Group list is being populated.

Navigate to: Configure > Security Service Edge > Secure Access > Client-based Access > Rules.

Click "+ Add" to create a new Secure Access Client rule or edit an existing rule.

In the Match Criteria configuration, navigate to the Users & Groups section. Under the Users &

Groups panel, click on Customize to begin specifying user-based access rules using the authentica-

tion profile you previously created.

10
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A @ i o Administrator -
W VERSA ACME-ONE CONFIGURATION :;) America/Bogota v = | MEngish v | @ g
Edit Client-based Access Rule: Secure_Access Windows_Profile
View
1 o
Operating System Users & Groups. Endpoint Posture ‘Source Geo Location & Traffic Action Gateways Client Configuration Agent Profile From EIP Review &Configure.

Source IP Address

By default we have chosen all users and groups to apply your security enforcements

I you prefer, you can select the specificusers or groups for the security posture.

Manitor Users & Groups ©
00
CC ¥ KnownUsers

Analytics

Com ) ) e

In the Users & Groups customization panel, select Selected Users as the user type. Then, under Enable
Rule for the following matched users or user groups, choose the appropriate authentication profile
(Example., AD_Server_Acme_One). This allows the policy to enforce access control based on Active Di-
rectory user group membership.

Note: When you choose an LDAP/AD server profile, you are able to list users and groups directly and select them for
Secure Access rule configuration.

W VERSA ACME-ONE CONFIGURATION (‘j AmericafBopota ~ T | W8 Englsn ~ () | Oministator

> Service Provider Administrator

Edit Client-based Access Rule: Secure_Access Windows_Profile
Source IP Address

B By default we have chosen all users and groups to apply your security enforcements

Configure IFyou prefer, you can select the specific users or groups for the security posture.

€ Back Users & Groups
UserTyDel @ SelectedUsers | O KnownUsers
Enable Rule for the following matched Users or user groups

2| | 20 server.Acme One

User Groups Users

Search for User Group:

User Groups(0)  + Add New User Group

Name Distinguished Name (DN)

Ce ) =) e S

In this step, you can choose to add specific users or groups to enforce security policies.

Use  the User  Groups or Users tabs  to select  the desired entries.

11
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W VERSA ACME-ONE CONFIGURATION o) AmericaBosota 1= | W Engisn v | @) et

i Edit Client-based Access Rule: Secure_Access Windows_Profile

View o o s s

By default we have chosen all users and groups to apply your security enforcements
7] it o
.

you prefer, you can select the specific users or groups for the security pasture.

€ Back Users & Groups
UserType  (® Selected Users Known Users

Enabile Rule for the following matched users or user groups

AD Server Acme One

User Groups (0} 4 Add New User Group

Name Distinguished Name [DN)

After reviewing all configuration sections, click Save to apply the settings to the current Secure Access Profile. Then go
to the Publish section at the top-right corner of the screen and click Publish.

SAML Authentication

Security Assertion Markup Language (SAML) is an open standard for secure authentication and authorisation between
an Identity Provider (IdP) and Service Providers (SPs), allowing users to authenticate once with the IdP and then seam-
lessly access multiple applications without re-entering credentials. It uses XML-based assertions to securely pass iden-
tity and authorisation data between parties, enabling web-based single sign-on (SSO) to services like Salesforce, Office
365, or Slack. In this workflow, platforms like Okta act as the IdP, verifying the user's identity and issuing a SAML asser-
tion (secure token) to the SP, which grants access based on the trusted authentication. (SP), granting access without
additional logins. Okta’'s SAML implementation is widely used for integrating third-party apps and simplifying enter-
prise authentication.

OKTA

Scenario

Within the enterprise context, Okta functions as the centralized Identity Provider (IdP) responsible for managing user

identities and will be integrated with Versa SASE. When a user initiates a connection, the Versa SSE Gateway redirects
the login request to Okta, which performs identity validation and returns a SAML assertion. This process grants access
based on the User or group.

12



Cloud

VERSA

NETWORKS

Enterprise
Datacenter

Branch-1

Remote Site

OKTA Portal Configuration
Create an Application in the OKTA portal.

e Create an application on Okta.

e Add users to the application.

1. login to your OKTA admin console.

Navigate to: Application then Click on Applications >> Create App Integration.

il S o \ oe e
Admin Console <

@ Dashboard . Applications B8 Documentaion

Directory v

Developer Edition provides a limited number of apps.

Customizations v Deactivate unused apps or check out our plans page. Contact us to find a plan that is right for your organization.

Abplctions > I 1 Create App Integration || Browse App Catalog [T LI e R ‘ ‘ More
Applications 2

Self Service

i)

—_—
00
88

w

Search -

API Service Integrations

STATUS @ Okta Admin Console
O security v T 2
& Workflow v INACTIVE 0 Q) Okta Browser Plugin
dll Reports v
P Okta Dashboard
@ Settings v
o Saml_Demo_PSLAB o -
© Sase-fabricl o -

2. Inthe Create a New App Integration window, click SAML 2.0, and then click Next.

) VERSA
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Create a new app integration

Sign-in method 0OIDC - OpenlD Connect

Token-based OAuth 2.0 authentication for Single Sign-On (SSO) through API
endpoints. Recommended if you intend to build a custom app integration
with the Okta Sign-In Widget.

Learn More (3

O SAML20
XML-based open standard for SSO. Use if the Identity Provider for your

application only supports SAML.

SWA - Secure Web Authentication
Okta-specific SSO method. Use if your application doesn't support QIDC or
SAML.

API Services
Interact with Okta APIs using the scoped OAuth 2.0 access tokens for

machine-to-machine authentication.

Cancel Next

) VERSA

3. In the General Settings > App name field, enter an application name, and then click Next.

okta

Admin Console
(» Dashboard
Directory

2 Ccustomizations
88 Applications
O security

& Workflow

dl Reports

@ Settings

Diego Chaves v
0% ar 28
Q F F @ 8 i ev-asanzzse

# Create SAML Integration

- °Ganeral Settings Configure SAML Feedback

1 General Settings

[ ACME-ONE-SAMIL| ]
App logo (optional) (&) E|

©

App visibility Do not display application icon to users

© 2025 Okta, Inc.  Privacy  Statussite  OK12 Cell (US)  Version 202507.3E  Feedback

e Define custom attributes.

4.

In the SAML settings, enter information for the indicates fields.

14
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Field

Description

Single Sign-On URL

URL where Okta sends SAML responses.
Format: https://<SASE-GW-FQDN > /versa-flexvnf/saml/login-consumer.

Example: https://acme-one-sasegwdiegos-lab.versanow.net/versa-flexvnf/saml/login-con-
sumer

Audience URI (SP En-
tity ID)

Service Provider (SP) entity ID:
Format: https://<SASE-GW-FQDN >/metadata.

Example: https://acme-one-sasegwdiegos-lab.versanow.net/metadata

Default Relay State

Used for IdP-initiated SSO:-
System user: vd-ui:system

Tenant user: vd-ui:<organization-name>

Attribute Statements

Define attributes such as role, organisation, and idle timeout. (Case-sensitive)

Group Attribute
Statements (op-
tional)

Enables Versa to import user-to-group mappings from Okta Configuration: -
Name: https://schemas.microsoft.com/ws/2008/06/identity/claims/groups
Name format: Unspecified

Filter: Regex (.*)

This ensures all groups a user belongs to are included in the SAML assertion, enabling
group-based policies (Internet Protection, Private App Protection, etc.).

Preview the SAML
Assertion

Use this option to preview. Copy the metadata and save as an XML file for Versa configu-
ration.

<?xml version="1.8" encoding="UTF-8"?>

<saml2:Assertion ID="id-5773745532411060288246009139" Issuelnstant="2025-88-08T17:10:21.828Z" Version="2.0"
xmlns:saml2="urn:oasis:names:tc:SAML:2.@:assertion">
<saml2:Issuer Format="urn:oasis:names:tc:SAML:2.0@:nameid-format:entity"/>

<saml2:Subject>

<saml2:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">userName</saml2:NameID>
<saml2:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.@:cm:bearer”>

<saml2:SubjectConfirmationData NotOnOrAfter="2025-88-88717:15:22.008Z" Recipient="https://acme-one-sasegwdiegos-lab.versanow.net/versa-flexvnf/saml/login-consumer"/>
</saml2:SubjectConfirmation>

</saml2:Subject>

<saml2:Conditions NotBefore="2025-08-88717:05:22.088Z" NotOnOrAfter="2025-88-88717:15:22.608Z">
<saml2:AudienceRestriction>
<saml2:Audience>https://acme-one-sasegwdiegos-lab.versanow.net/metadata</saml2:Audience>
</saml2:AudienceRestriction>

</saml2:Conditions>

<saml2:AuthnStatement AuthnInstant="2025-28-88717:10:21.828Z">

<saml2:AuthnContext>

<saml2:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport</saml2:AuthnContextClassRef>

</saml2:AuthnContext>
</saml2:AuthnStatement>
<saml2:AttributeStatement>

<saml2:Attribute Name="https://schemas.microsoft.com/ws/2008/06/identity/claims/groups” NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"” xsi:type="xs:string">GroupName Match Starts with ".*" (ignores case)
</saml2:AttributeValue>

</saml2:Attribute>

</saml2:AttributeStatement>

</saml2:Assertion>

Configure the parameters as shown in the previous table, and then click Next.

15
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=iCreate SAML Integration

General Settings o Configure SAML Feedback
A SAML Settings
What does this form do?
General This form generates the XML needed

for the app's SAML request.
Single sign-on URL @ https:/facme-one-sasegwdiegos-lab.versanow.netfvars

Use this for Recipient URL and Destination URL neads?

The app you're trying to integrate with

Audience URI (5P Entity 1D} @ I . P - R
https:/facme-one-sasegwdiegos-lab.versanow.net/met chould have its own documentation on

using SAML. You'll need to find that
Default RelayState @ doc, and it should outline what
information you need to specify in this

If no value is set, a blank RelzyState is sent
form.

MName ID format @

Unspecified -
Application username @ Okta vsername .
Update application username on Create and update .

Show Advanced Settings

Attribute Statements (optional) LEARN MORE
Name MName format Value
{optional}
Unspecified = -

Group Attribute Statements (optional)

Name Name format Filter
lntianall
I https:fizchemas.mic Unzpecified - Matches regex v | ¥ I

In the Help Okta Support understand how you configured this application section, you can provide

optional information for Okta Support.

o Under App type, check This is an internal app that we have created (recommended for inter-
nal SSO integrations like Versa).

o Click Finish to complete the SAML integration setup.
Retrieve SAML Integration Details

After completing the previous steps, Okta displays the SAML configuration details required to set up
the SAML profile in Versa Concerto. Copy the Sign on URL, the Issuer value and Download the Sign-
ing Certificate file, CHANGE.

16
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SAML 2.0

Default Relay State

Metadata detalls
Metadata URL https://dev-
48982259.0kta.com/appfexkpzj7 1tINg6Exg675d7/sso/s
aml/metadata
E Copy
@ Hide details

Sign on URL https://dev-48982259.c0kta.com/app/dev-

48982259_acmeonesaml_1/exkpzj71tINg6xg675d7/ss
ofsaml

E Copy

Sign out URL https://dev-48982259.0kta.com

E Copy

Issuer http://www.okta.com/exkpzj71tINg6xg675d7

E Copy

Signing Certificate
+ Download E2 Copy

© Certificate fingerprint

Note: Rename the downloaded certificate file from .cert to .crt before use

7. Create the Groups and Users. Navigate to Directory>Groups then Click Add group

17
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ota (& e e o® mmom,
Admin Console <
@ Dashboard v Groups Sy

- Al Rules

(2]

Advanced search

Devices
Profile Editor Group source type AN . Showing 3
Directory Integrations & o Applcations
Profile Sources. # SaseFabric-Group 3 2

SaseFabric-Group

2 customizations -

ﬁ Everyone a o

53 appiicatons . Al users in your organization

o Okta Administrators

O security - Okta manages this group, which contains all administrators in your organization.

B workflow -

dll Reports v

© Senings -

©20250kia,Inc.  Privacy  Stalussite  OK12 Cell (US)  Version 2025073 E  Feedback

In the name field, enter a group name

Add group
MName

Engineering-Group

Description (optional) Engineering-Group

Refresh the page and click to the newly created group “Engineering-Group”.

After opening the group, go to the Applications tab and Click Assing Applications To assign the
newly created SAML application to the group.

18
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O Engineering-Group | 1

Engineering-Group

Created: 8/8/2025 Last modified: 8/8/2025 View logs

People Applications 2Proﬁle Directories Admin roles

Applications

Group Members

3 Assign applications People, apps and directories can be

members of a group. People are

automatically assigned any apps that
are members of a group.

01101110

gilc’lléjn- Directories, like Active Directory or

0 oo Workday with profile management

01 1 enabled, will manage user profiles

01101110

01100111 when they are members of a group.
No applications assigned to this group Use Assign People to add people to

Use Assign applications to assign apps to this group this group. Use Assign applications to

do the equivalent for applications.

How do | edit the group name and
description?

Hover your mouse over the group
name or description to edit them
inline.

Select newly created SAML application

19



Assign Applications to Engineering-Group

Search...

© Sase-fabricl

© Saml_Demo_PSLAB

© ACME-ONE-SAML

|
x
4

) VERSA

To create users, Navigate to Directory>People, click Add Person, fill in the required user details in

the pop-up, assign the necessary groups, and save.

okta

Admin Console

@ Dashboard

| @ ooy ] 1
=2

Graups

Devices

Profile Editor
Directory Integrations

Profile Sources

"

Customizations

Applications

3

Q

Security

a8

Werkflow
dl) Reports

© Settings

People

3 [Amu person l [ < Reset passwords ] [ Mare actions ¥

Aa)

Advanced search

Status ANl

Parson & usemamo

Test2 Test2
test2@versalab.com

Test test
testigversalab.com

Diego Chaves
diego_hard10@hotmail.com

Diego Chaves
diego.g@versa-netwarks.com

©20250kia, Inc.  Privacy  Status site

Primary email

testz@versalab.com

testi@versalab.com

diego_hard10@hotmail.com

diego.o@versa-networks.com

OK12 Cell (US)  Version 2025.073F  Feadback

Diega Chaves v
@ B ude-asssarse

Qe

Showing 4 of 4 @

status

Active
Password expired
Active

Active

20
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In the Add Person window, set User type to User, enter the first name, last name, username, and
primary email, select the required group (Example Engineering-Group), choose Activate now, set a

password, and ensure User must change password on first login is checked before saving.

Add Person

User type @ User v
First name VIP1

Last name VIP

Username vipl@acme-one.com

Primary email

vipl@acme-one.com

Groups (optional) [{} Engineering-Group x ]

Activation Activate now -

® | will set password

@ User must change password on first login

Do not send unsolicited or unauthorized activation emails. Read more

m Save and Add Another Cancel
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Concerto OKTA Authentication Profiles
Navigate to User and Device Authentication Profiles

Go to: Configure > Security Service Edge > Users and Device Authentication > Profiles then “+ Add”

WVERSA  ACME-ONE CONFIGURATION o) AmericuBogots = W Engin v | @

' |

User and Device Authentication Profile

User and Device Authentication Profiles (1) @ Refresh B Select Columns ~
Name Tpe Description T Last Modified
> | ADServer Acme One LDAP /2602025, 4:54:47 PM
Administrator
Showing1-10f 1results 10 = Rows per Page Gotopage 1+ 1

Select SAML, Click Get Started

Add User and Device Authentication Profile x
Select which user / device authentication profile you would like to configure.
©
LDAP SAML RADIUS
LDAP is aclient-server protocol that enables a SAMLI for
network device to access an LDAP server, which sothat they can access multiple services and i before allowir
y web them to access a network, a device, or related
attribute-based information. browser-based single sign-on (SSO). services.
Versa Directory User Certificate Based Device Certificate Based
vvvvv Cartit L Cartit
of users and groups for authentication pur s tovalidate the identity of users. When you enable datethe identity of devices. ¥
‘weell as add individual users and user groups.
initiates a for usersto initiat to client for users to
. o o ertificat portal or tal
Note: Only one Versa Directory authentication profile il sa g O o ridiod sl ety onsesclie;

canbe added.

Cancel Get Started

Select OKTA

22



) VERSA

To configure the settings, use the information collected in Step 6 from Okta SAML app created. In
the Okta admin console, go to Applications, open the created app, click Sign On, and scroll down
to view the SAML setup instructions.

SAML 2.0

Default Relay State

Metadata detalls
Metadata URL https://dev-
48982259.0kta.com/fapp/exkpzj71tINgBxg675d7/ss0/s
aml/metadata
E Copy
@ Hide details

Sign on URL https://dev-48982259.ckta.com/app/dev-

48982259 acmeonesaml_1/exkpzj7 1tINg6xg675d7/ss

ofsaml
E Copy
Sign out URL https://dev-48982259.0kta.com
E Copy
http://www.okta.com/exkpzj71tINgBxg675d7
E Copy

Signing Certificate
& Download E¢ Copy

© Certificate fingerprint

The information collected from the Okta SAML application created in Step 6 (In this example,
ACME-ONE-SAML) is used here to complete the configuration. Single Sign-on URL, Service Pro-
vider Entity ID and Identity Provider Entity ID are mandatory fields and the signing certificate
from Okta must be uploaded. This information should be gathered beforehand to set up the au-

thentication profile correctly.
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Add SAML Authentication Profile x

Settings Users Ardl User Grougs Review & Submit

Select SAML Type

(-]
okta WPingldentity. 1] Office 365 > (o) ==
OKTA Ping |dentity Office 365 Microsoft Entra ID Google |AM Clsco Duo Other

Single Sign-on URL " Single Sign-out URL

Service Provider Cartficate
~Select- =+ AddNew
Idantity Provider Certificate ™
~Selert— * & AddNew
Prefix D ‘Cache Expiry Time (mins)
0
‘Group Attribute ‘Concurrent Logins

Reply URL [Assertion Consumer Reply URL)

Complete the parameters using the values from the Okta app:

Example:

Single Sign-on URL: https://dev-48982259.okta.com/app/dev-48982259_ac-

meonesaml_1/exkpzj71tINg6xg675d7/sso/saml

Service Provider Entity ID: https://acme-one-sasegwdiegos-lab.versanow.net/metadata

Identity Provider Issuer: http://www.okta.com/exkpzj71tINg6xg675d7

In the Prefix ID field fill it as OKTA

) VERSA
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https://dev-48982259.okta.com/app/dev-48982259_acmeonesaml_1/exkpzj71tlNg6xg675d7/sso/saml
https://dev-48982259.okta.com/app/dev-48982259_acmeonesaml_1/exkpzj71tlNg6xg675d7/sso/saml
http://www.okta.com/exkpzj71tlNg6xg675d7

Add SAML Authentication Profile

Settings. Users A Uses Goonaps

Select SAML Type
okta WPingIdentity. 1] Office 365 >
OKTA Ping Identity Office 365 Microsoft Entra ID
Single Signron URL * Single Sign-out URL
 cmeoncsan " |

Service Provider Entity ID* »

| Cor—

Identity Provider Entity 1D 7

hitouferwchtacomedpei71UNgEE8750T

PrefixID

Group Attribute

Reply URL {Assertion Consumer Repty URL)

Service Provider Certificate:
sebect-

Identity Provider Certificate "
Select

Cache Expiry Time (mins)

n

Concurrent Logins

Fevien & Submit

o =us

Google 1AM GiscoDun Other

+ o AddNew

-+ AddNew

) VERSA

Then Upload the Identity Provider Certificate by clicking on the Add New button. Rename the

downloaded certificate file from .cert to .crt before use on concerto.

Add SAML Authentication Profile

Settings. Users and User Grouns

Select SAML Type
okta MPingldentity. 1] Office 365 >
OKTA Ping Identity Office 365 Microsoft Entra 1D
‘Single Sign-on URL* Single Sign-out URL.
e _acmaones ami_

Service Provider Entity ID* Service Provider Certificate

i e s sl e etatta s
Identity Provider Entity ID* » Identity Provider Certificate *

sk g geTSET st
Prefix 1D Cache Expiry Time (mins|

o ©
Groug Attritute. Concurrent Loging

.

Reply URL {Assertion Consumer Regly URL)
*  hitips:fiacs onsumer

Name to CA-Chain Name

upload certificate issue by clicking on the Upload File.

o =sus

Gocgle 1AM ClscoDun Other

= 4 Add New

o # Addnew
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Add Certificate/CA-Chain/Private Key

Certificate Type ® CAChain

Allowed file formats are .crt, .cer or .pem

CA-Chain Name ™

OKTA_ACME

Upload File

Then Add

Add Certificate/CA-Chain/Private Key

Certificate Type (8 CAChain

Allowed file formats are .crt, .cer or .pem

CA-Chain Name ™

OKTA-ACME

Upload File

If certificate was uploaded successful, the certificate details will be displayed

Add SAML Authentication Profile "
)
suores ekt Reven ot
Selct s T
L 1| )
okta WPingidentity. ) Offica 365 > (o] =ls
o [r— - Moo —— chotnn oot
S Sgrn L S St UL
e Provides Bty I0° Sevic prode Catise
s o s s s e -+ ssdhen
Idertity Provider Enity 1D* * Identity Provider Certificate *
o g o -+ sciben

-
M OKTAACME
FlaMame  OKTA-ACME S
bTe e 48582259
By 46562259

Vit I025-0806127319 1o 2055-06-08 122418
PrefxiD Cache Expiry Time i)

o "
Group tribute Concuerent Logins

1
Reply URL (esertion Corsurmer Reply URL)

Then Next

On the Users and User Groups page, you can associate either an individual user list or a complete

group list with the SAML authentication profile. The advantage of this approach is that a group or
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user list can be adjusted and applied within the authentication profile, allowing you to enforce a

specific Secure Access rule for those users. You can define users and groups in two different ways:

e User List: upload a CSV file or manually add users one by one.
e Group List: upload a CSV file or manually add a user group. In this example, we will use the
group created earlier in the Okta portal (for example, Engineering-Group). Add the group,

click Add, and then click Next to continue.

On the Review & Submit page, enter a Name and Description for the profile, then review all con-
figuration details including general information, SAML settings, and assigned users or groups. Once

confirmed, click Save to complete the profile creation.
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Add SAML Authentication Profile

io
o

General
Hame Dascription

HEME SAMLACME T

Settings  # Edt

SAMLType oKTA

Singe o UL o
Single Sign-out URL

Servios rovider Entty 10 etpace-one-sasegneiegas b verseawretimetadits

Servioe Provider Crtifate

by hitoy HINgAegs7547
dentity Frovider Cestificate: OKTAACME

PrefuiD oxTA

Cache Expiry Tioms Gvine) 10

Cancurrent Logins 1

Group Attribute

Ry URL (Assestion Corsuemas Reply URL)

Users & User Groups.  # £t

Users{o) User Groupet)
Nousers Enginessing G

- -

After creating and Publishing the Authentication Profile, you must apply them to the Secure Access Client policy to
enforce authentication and apply the corresponding security policies.

Microsoft Entra ID

Microsoft Entra ID is a cloud-based identity and access management service that provides secure single sign-on (SSO)
to Microsoft 365, SaaS apps, and on-premises resources using standards like SAML, OAuth, and OpenID Connect.

Scenario
The same scenario described above also applies when using Entra ID as the Identity Provider. Because it is a cloud-
based IdP, Entra ID can seamlessly integrate with Versa SASE via SAML, validating user identities and issuing assertions
that grant access to both cloud services and enterprise applications under consistent policy enforcement.

Entra ID Configuration

Create an Enterprise Application in the Entra ID portal.

e Create a new application in Entra ID.

e Assign users or groups to the application.

1. Log in to your Entra ID / Azure portal.

Navigate to: Enterprise apps > New application.
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£ Search resources, services, and docs (G+/) l % Copilot

DIEGO TEST LAR (DIEGOLABVE

Home > Enterprise applications

# Home . - o
Enterprise applications | All applications X
& Agents Diego Test Lab
<<. 2 -+ New application] () Refresh Download (Export) o Preview info == Columns
% Favorites e Overview
@ Overview View, filter, and search applications in your organization that are set up to use your Microsoft Entra tenant as their
Identity Provider.
Entra ID N
© E= X Diagnose and solve problems
The list of applications that are maintai by your ization are in application registrations.
@  Ovenview M
lanage
O Search by application name or object ID
8 users = Al applications v ape !
icati — i P A : 2
= Groups B Private Network connedors Application type == Enterprise Applications > Application ID starts with X 7 Add filters
3 applications found
3 & User settings . .
I Devices MName T, ObjectID Application ID Homepage URL Created on T
BR App launchers ~ e
Iﬁl Enterprise apps — et v Google Work... 03eed589-93c8-4{76... 4d7fe9fb-5646-447f-.. https;//drivegoogle.... 8/12/2025
5] Custom authentication
extensions . ACME-ONE-S... 576b6311-9a56-4d3... 45e6c18b-692d-41d. https://account.activ... 9/3/2025
B App registrations
Security - Intune-MDM  daB91466-9d12-4c1... cc813451-f42b-41bd... 7/30/2025
o Roles & admins < »

& Conditional Access

2§ Delegated admin partners
@ Consent and permissions

B Domain services v
Activity

-~ - v

2. Select Create a new application

Click + Create your own application.

Enter the application name (Example, ACME-ONE-SAML).

Select Integrate any other application you don’t find in the gallery (Non-gallery).

Click Create.

Microsoft Entra admin center £ Search resources, services, and docs (G+/)

P S Home > Enterprise applications | All applications > Create your own application N
Browse Microsoft Entra Gallery

L (=5 ,’0? Got feedback?

1 | ~+ Create your own application I &7 Got feedback?
Favorites ' If you are developing your own application, using Application Proxy, or want to integrate an
The Microsoft Entra App Gallery is a catalog of thousands of apps tha  application that is not in the gallery, you can create your own application here.
When deplaying an app from the App Gallery, you leverage prebuilt 1

*

& EntralD ~ application here. If you are wanting to publish an application you hav  What's the name of your app?
can file a request using the process described in this article
. ZI ACME-ONE-SAML ¢|I
@ Overview |
Search licati i ign-
Q Users (12 Search appliction SingleSIan  what are you looking to do with your application?

—3 Federated SSO (@ Provisioning O Configure Application Proxy for secure remote access to an on-premises application
 Groups () Register an application to integrate with Microsoft Entra ID (App you're developing)
[ Showing 50 of 1596 results 3| ) Integrate any other application you don't find in the gallery (Non-gallery) I

evices
@ Enterprise apps
&frankly
Andfrankly Pulse AB
B App registrations &frankly _5; e u
&a Roles & admins "

& Delegated admin partners

B Domain services v
«

123FormBuilder S50 | |
3. Set up SAML-based SSO

e Open the newly created application.

e Go to Single sign-on and select SAML as the method.
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tH Microsoft Entra admin center B Search resources, services, and docs (G+/)

) VERSA

ves@diegolab.

I T Copilot &

goc
DIEGO TEST LAB (DIEGOLABVER.

A

- > Browse Microsoft Entra Gallery > ACME-ONE-SAML | Overview > Enterprise applications | All applications > ACME-ONE-SAML

ﬂ Home
3 ACME-ONE-SAML | Single sign-on X
& Agents Enterprise Application
«
% Favorites 2 M - i .
s Select a single sign-on method  Help me decide
{Il Properties
9 EntralD ~
&3 Owners
@ Overview a . ® Disabled
- Roles and administiators Single sign-on is not enabled. The user
A  Users & Users and groups m‘;":pi;ab'e to launch the app from
AR Groups 3 Single sign-on
@ Provisioning
& Devices
£ Application proxy
I a Enterpn;e EpE= C Self-service
B App registrations G S{AMI. o
Rich and secure authentication to
B . applications using the SAML (Security
So Roles & admins Security Assertion Markup Language) protocol
&3 Delegated admin partners % Conditional Access
. Permissions
O Domain services
« @ Token encryption
-
4.  In the SAML settings, enter information for the indicates fields.
Field Description

Reply URL (Assertion
Consumer Service
URL) and Sign on URL
(Optional)

Enter the URL to which Okta sends OAuth responses. The responses are sent in the format
. https://saseGw-FQDN/versa-flexvnf/saml/login-consumer. (Here the Gateway's
FQDN is used as the main URL +/versa-flexvnf/saml/login-consumer ). In the exampe
https://acme-one-sasegwdiegos-lab.versanow.net/versa-flexvnf/saml/login-con-
sumer

Identifier (Entity ID)

Enter the service provider entity ID, which is https://saseGw-FQDNt/metadata. In the
example https://acme-one-sasegwdiegos-lab.versanow.net/metadata

Attribute Statements

Enter the role, organization, and idle timeout attributes. The attribute strings are case sen-
sitive.

Group Attribute
Statements (optional)

To allow Versa to receive all user-to-group mappings from Okta, configure a group attrib-
ute statement as follows:

Name: https://schemas.microsoft.com/ws/2008/06/identity/claims/groups

Name format: Unspecified

Filter: Select Regex (or equivalent option) and enter .*

This configuration ensures that all groups a user belongs to are included in the SAML as-

sertion. Versa uses this information to apply group-based mappings for Internet Protec-
tion rules, Private App Protection, and other user-based policies.

Preview the SAML
Assertion

Click to preview the SAML assertion. Copy the metadata, and save it as an XML file.
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<?xml version="1.8" encoding="UTF-8"?>

<saml2:Assertion ID="id-5773745532411060288246009139" Issuelnstant="2025-08-08T17:10:21.828Z" Version=
is:names:tc:SAML:2.@:assertion">

rn:oasis:names:tc:SAML:2.0:nameid-format:entity”/>

2.0"

ubject>
12:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">userName</saml2:NameID>
<saml2:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml2:SubjectConfirmationData NotOnOrAfter="2025-88-88717:15:22.008Z" Recipient="https://acme-one-sasegwdiegos-lab.versanow.net/versa-flexvnf/saml/login-consumer"/>
</saml2:SubjectConfirmation>
</saml2:Subject>
<saml2:Conditions NotBefore="2025-08-88717:05:22.008Z" NotOnOrAfter="2025-88-88717:15:22.008Z">
<saml2:AudienceRestriction>
<saml2:Audi https:// di lab.ver .net, </saml2:Audience>
</saml2:AudienceRestriction>
</saml2:Conditions>
<saml2:AuthnStatement AuthnInstant="2025-28-88717:10:21.828Z">
<saml2:AuthnContext>
<saml2:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.08:ac:classes:PasswordProtectedTransport</saml2:AuthnContextClassRef>
</saml2:AuthnContext>
</saml2:AuthnStatement>
<saml2:AttributeStatement>
<saml2:Attribute Name="https://schemas.microsoft.com/ws/2008/06/identity/claims/groups"” NameFormat="urn:oasis:names:tc:SAML:2.8:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:string">GroupName Match Starts with ".*" (ignores case)
</saml2:AttributeValue>
</saml2:Attribute>
</saml2:AttributeStatement>
</saml2:Assertion>

5. Configure the parameters as shown in the previous table, in Basic SAML Configuration and then

click Save.

P Search resources, services, and docs (G+/) I T Copilot

P — Home > Enterprise applications | All applic Basic SAML Configuration w
& Agents Enterprise Application O Sove & Got feedbadk?
« a

K Favorites v B Overview = Identifier (Entity ID) *

[ Deployment Plan The unique ID that identifies your application to Microsoft Entra ID. This value must be unique across all applications in your
& EntralD A Microsoft Entra tenant. The default identifier will be the audience of the SAML response for IDP-initiated 550,

K Diagnose and solve problems

i Default
@ Overview " i
anage
g ! https://acme-one-sasegwdi b.versanow.net/metadata o)

A Users I} Properties ‘Add identifier

2
A Groups & Owners |
B Devices & Roles and administrators IRepIy URL (Assertion Consumer Service URL) * @ I

2 Users and groups The reply URL is where the application expects to receive the authentication token. This is also referred to as the “Assertion

|®  Enterprise apps Consumer Service” (ACS) in SAML
D Single sign-on
3 Index Default
B8 App registrations D Provisioning
| itpsi/acme-one-sasegwdiegos-lab versanow.netiversa-flexvnf/sami/login-consu... | 7 @
& Roles & admins ' Application proxy
Add reply URL
; C Self-senvice
& Delegated admin partners
] u ib

B  Domain services

Security Sign on URL is used if you would like to perform service provider-initiated single sign-on. This value is the sign-in page URL for
@ Conditional Access your application. This field is unnecessary if you want ta perform identity provider-initiated single sign-on.

® Conditional Access

§ hitps://acme-one-sasegwdiegos-lab versanow.net/versa-flexvnf/saml/login-consumer v
v

1 Multifactnr authantication 2. Permissions I | !

6. Define Attributes & Claims.

Add the following mappings, click + Add new claim:

e user.userprincipalname > name
e "ACME-ONE" > organization

e user.assignedroles > role
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Home > Enterprise applications | All applications > ACME-ONE-SAML | SAML-based Sign-on > SAML-based Sign-on > Attributes & Claims >

Manage claim X

Save X Discard changes 27 Got feedback?

Name * I I givennamdl \/]

Namespace ‘ http://schemas.xmlsoap.org/ws/2005/05/identity/claims v |

~ Choose name format

Source * @ Attribute O Transformation O Directory schema extension

Source attribute * I ‘ user.givenname I v

v Claim conditions

v Advanced SAML claims options

Home > Enterprise applications | All applications > ACME-ONE-SAML | SAML-based Sign-on > SAML-based Sign-on > Attributes & Claims >

Manage claim - X

Save X Discard changes A7 Got feedback?

Name * | organization | \/|

Namespace ‘ Enter a namespace URI NG |

' Choose name format

Source * @ Attribute O Transformation O Directory schema extension

Source attribute * ‘ "ACME-ONE" I A

v Claim conditions

v Advanced SAML claims options

Home > Enterprise applications | All applications > ACME-ONE-SAML | SAML-based Sign-on > SAML-based Sign-on > Attributes & Claims >

Manage claim - X

Save X Discard changes 27 Got feedback?

Name *

Namespace

v Choose name format

Source *

Source attribute *

~ Claim conditions

v Advanced SAML claims options

I‘ role I

‘ Enter a namespace URI

@ Attribute O Transformation O Directory schema extension

I user.assignedroles I

o Configure Group Claims referring to previous table Group Attribute Statements.

Click + Add a group Claim
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Home > App registrations > Enterprise applications | All applications > ACME-ONE-SAML | SAML-based Sign-on > SAML-based Sign-on >

Attributes & Claims X

7 Add new claim

A7 Got feedback?

Required claim
Claim name Type Value

Unique User Identifier (Name 1D) SAML user.userprincipalname [... ***

Additional claims

Claim name Type Value
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailadd... SAML user.mail
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname  SAML user.givenname oo
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/name SAML user.userprincipalname
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname  SAML user.surname o

v Advanced settings

e Under Group Claims, choose All groups.

e Set Source attribute to Group ID.

Group Claims X

Manage the group claims used by Microsoft Entra ID to populate SAML tokens issued to your app

Which groups associated with the user should be returned in the claim?

None

(®) Allgroups

Security groups
(O Directory roles
() Groups assigned to the application

Source attribute *
Group ID ~

Emit group name for cloud-only groups ©

~ Advanced options

e (Click Advance options then Enable Customize the name of the group claim > set name as groups.
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Group Claims x

Manage the group claims used by Microsoft Entra 1D to populate SAML tokens issued 1o your 3pp

Emit group name for cloud-only groups ()

[ Filter groups

Attribute to match
Match with
String
B Customize the name of the group claim
Name {reguired)
groups v
Namespace (optional)

[ Emit groups as role claims @ 1

e Click on Apply regex replace to groups claim content then set Regex replace:

o Pattern: .*

o Replacement: $0

Group Claims X

Manage the group claim:

d by Microsoft Entra 1D to populate SAML tokens issued to your app

String a

B Customize the name of the group claim

Name (required)
[ groups v

Namespace (optional)

(] Emit groups as role dlaims @

I B Aoply regex replace to groups claim cunten(l

Regex pattern * (@

Regex replacement pattern % ()
* |

[] Expase claim in JWT tokens in addition to SAML tokens

e Retrieve SAML Integration Details
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After completing the previous steps, Entra-id displays the SAML configuration details required to set
up the SAML profile in Versa Concerto. Copy the Sign on URL, the Issuer value and Download the
Signing Certificate file.

Home > App registrations > Enterprise applications | All applications > ACME-ONE-SAML »

ACME-ONE-SAML | SAML-based Sign-on - %

Enterprise Application

B Overview

[ Deployment Plan

K Diagnose and salve problems

« T Upload metadatafile ) Change single sign-on mode
a .

SAML Certificates

Token signing certificate

Test this application A Got feedback?

Manage & Edit
Status Active

ilﬁ Properties Thumbprint 0382CE53329AACFO16A20F1C7419EBFOE150D786
Expiration 9/4/2028, 10:34:57 AM

& Owners Notification Email diegochaves@diegolabversa.onmicrosoft.com

L. Roles and administrators App Federation Metadata Url | https://login microsoftonline.com/a08ab2d2-a5df-... 1)

ICertiﬁcate Base64) Download I

& Users and groups Certificate (Raw) Download

3 single sign-on Federation Metadata XML Download

@ Provisioning o » .

& sppicstion pony Venﬁ.callcn certificates (optional) & i
Required No

©  Self-service Acti.ve 0
Expired 0

] Custom security attributes

Security Set up ACME-ONE-SAML

& Conditional Access . . .
You'll need to configure the application to link with Microsoft Entra ID.

5
ilu Permissions Login URL https://login.microsoftonline.com/a08ab2d2-asdf-...

[Microsoft Entra Identifier

@ Token encryption hitps://stswindows.net/a08ab2d2-a5df-481b-9ffa... [

[Logout URL

https://login.micresoftonline.com/a08ab2d2-a5df

Activity

23 sign-in logs v

e Create the Groups and Users.

Navigate to Microsoft Entra admin Center user > Group then Click New Group

Microsoft Entra admin center A Search resources, senvices, and docs (G+/) I T Copilot

4 Home > Groups| Overview > Users > Groups | Overview > New Group
~ L P i
Home
o Groups | Overview - X
& Agents Diega Test Lab
« L Download groups | [ Preview features
% Favorites v O Overview ‘ ‘
2 All groups Overview  Tutorials
Entra ID ~
S ntra 2 Deleted groups
0 Search your tenant
@ oOveniew X Diagnose and solve problems
settings Basic information
1]
& Genera Total groups 4 Dynamic groups 1
) ) Expiration
B Devices M365 groups 3 Cloud groups 4
£ Naming policy
Enterprise apps Sexurity groups 1 On-premises groups 0
Activity
BB App regisirations
h 2 Privileged Identity Management Alerts
&@ Roles & admins 7= Access reviews
- Audit b P
8 Delegated admin partners @ suditlogs Feature highlights
) Domain sendces & Bulk operation results
N Troubleshoating + Support fi‘g Access reviews 0 Conditional Access
&  Conditional Access A2t Make sure only the right pecple have continued Control user access based on Conditional Access
o ) & New support request access. policy to bring signals together, to make decisions,
Multifactor authentication and enforce organizational policies.
Q identity Secure Score
uick actions
& Authentication methods v Q

In the name field, enter an group name
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Home > Groups | Overview > Users > Groups | Overview > New Group > Groups | Overview >

New Group

P? Got feedback?

Group type * @

| Security v |

Group hame * ()

[ viP_Group |

Group description &

| Enter a description for the group |

Microsoft Entra roles can be assigned to the group @

Yes

Membership type * ©

[ Assigned ~

Owners

No owners selected

Members

No members selected

Refresh the page and click to the newly created group “VIP_Group”.

To create users Navigate to Navigate to Microsoft Entra admin Center > user, click New User.

In the Basics tab, define the User Principal Name (UPN) and Display Name.

Example:

UPN - vip@acme-one.onmicrosoft.com

Display Name — vip
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Home > Groups | Overview > Users > Groups | Overview > New Group > Groups | All groups > VIP_Group | Roles and administrators > Users >

Create new user - X

Create a new internal user in your organization

Basics  Properties Assignments Review + create

Create a new user in your organization. This user will have a user name like alice@contoso.com. Learn more @

Identity
User principal name * vip | @ | diegolabversa.onmicros.. | [y
Domain not listed? Learn more 3

Mail nickname * vip

Derive from user principal name
I Display name * ‘ vip ‘ I

Password * [ e o | D
Auto-generate password

Account enabled @

< Previous Next: Properties > 27 Give feedback

In the Properties tab, add first name, last name, and user type (Example, Member).

Other fields such as job title or department are optional but can be filled for organiza-

tional use.

Home > Groups | Overview > Users > Groups | Overview > New Group > Groups | All groups > VIP_Group | Roles and administrators > Users >

Create new user - X

Create a new internal user in your organization

Basics Properties  Assignments Review + create

Identity

‘ VIP1 ‘

Last name [vie1 |

‘ Member v ‘

Authorization info - Edit Certificate user IDs

Job Information

Job title \ |

Company name ‘ ‘

Department \ |

Employee ID ‘ ‘

Employee type ‘ ‘

Employee hire date ‘

Office location ‘ ‘

[ < Previous | [ Next: Assignments > &7 Give feedback
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In the Assignments tab, click Add Group.

e Select the previously created VIP_Group (or any other relevant group).

This ensures the user inherits group-based claims when authenticating via SAML.

Home > Groups | Overview > Users > Groups | Overview > New Group > Groups | All groups » VIP_Group | Roles and administrators > Users >

Create new user

Create a new internal user in your organization
Basics  Properties Assignments  Review + create
Make up to 20 group or role assignments. You can only add a user to a maximum of 1 administrative unit.

—+ Add administrative unit |4 Add group |4 Add role

No assignments to display.

< Previous | [ Next:Review + create > 27 Give feedback
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Select group X
A
@ Try changing or adding filters if you don't see what you're looking for. Selected (1)
'9 Reset
Search
[ 2 | ﬂﬁ VIP_Group 0]
5 results found
All  Groups
Name Type Details
D & All Company Group allcompany@diegolabversa.onmicrosoft.com
‘.‘ All Users Group Dynamic groups are not allowed.
D ﬂ Diego Test Lab Group DiegoTestLab@diegolabversa.onmicrosoft.col
D & Group for Answers in Viva Engag...  Group groupforar invivaengagedonotdelete16:
—
& VIP_Group Group
4 [ ] 4

e Still under Assignments, click Add Role.
o From the directory roles list, assign security-related roles as required. For example:
= Security Reader - allows read access to security reports.
= Security Administrator — manages security configuration.
o Roles are optional for SAML authentication itself but useful if role claims are mapped

into SAML tokens for authorization in downstream apps.
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Home > Groups | Overview > Users > Groups | Overview > New Grou Directory roles X
Create new user

Create a new internal user in your organization a

Choose admin roles that you want to assign to this user. Learn more
Basics Properties Assignments ~ Review + create
_— ‘P securi x |
Make up to 20 group or role assignments. You can only add a user to a maxin -
Role Ty Description
) ) Assign custom security attribute keys and values to supported Microsoft Entra
+ Add administrative unit - Add groug. [J e Attribute Assignment Administrator 1 cjerts
- Read custom security attribute keys and values for supported Microsoft Entra
D @ Attribute Assignment Reader ] . ol ” PP
objects.
Type Name . . . . .
P D g Attribute Definition Administrator ] Define and manage the definition of custom security attributes.
Group VIP_Group [[] s Attribute Definition Reader J Read the definition of custom security attributes.
[ L Atribute Log Administrator Read audit logs and configure diagnostic settings for events related to custom
security attributes.
D @ Attribute Log Reader Read audit logs related to custom security attributes.
- S . Read and edit the provisioning configuration of all active custom securi
D g Attribute Provisioning Administrator P oning & v
attributes for an application.
. P Read the provisioning configuration of all active custom security attributes for
D & Attribute Provisioning Reader @ P 9 9 v
an application.
[J (% Cloud App Security Administrator Can manage all aspects of the Cloud App Security product.
Provides designated security personnel with read-only access to network traffic
D g Global Secure Access Log Reader logs in Microsoft Entra Internet Access and Microsoft Entra Private Access for
detailed analysis.
[] Jp Message Center Privacy Reader Can read security messages and updates in Office 365 Message Center only.
) . Can read security information and reports, and manage configuration in
B e security Administrator I Microsoft Entra ID and Office 365.
[ 1 Security Operator Creates and manages security events.
e Can read security information and reports in Microsoft Entra ID and Microsoft
Crrovious | | ot Review 3¢

Review & Create

Confirm the user configuration in the Review + create tab.

Assigning Groups to the SAML Application in Entra ID

Once the group and users are created, the final step is to assign them to the SAML application so

they can authenticate.

1.

Microsoft Entra admin center

Navigate to the Enterprise Apps (Example.,, ACME-ONE-SAML) > Users and groups.

P Search resources, services, and docs (G+/)

T Copilet

> Users > Enterprise applications | All applications > ACME-ONE-5AML | Users and groups > Enterprise applications | All applications >

A Home
ACME-ONE-SAML | Overview X
& Agents Enterprise Applicatien
i
*  Favorites e & Overview Properties
[ Deployment Plan Name @
Entra ID
e X Diagnose and solve problems ACME ONE-SAML [
@O Overview Application ID (@)
Manage
45e6c18b-692d-41d2-8161-... [
A Users Il Properties
ObjectID @
A Groups & Owners | 57606311-0a56-4d32-8011... [
& Roles and administraters .
T Getting Started
3
D Single sign-on
App registrations  Provisioning & 1. Assign users and groups 3) 2 Setupsinglesignon
. ot Provide specific users and groups access Enable users (o sign into their application
£ Application pr
Roles & admins P! proxy to the applications using their Microsoft Entra credentials
€ self service Assign users and groups Get started
Delegated admin partners -

Domain services

]
‘o
&%
o
&

Conditional Access

Bl

Multifartar aithantisatinn

Security
® Conditional Access
& Permissions

®

3. Provision User Accounts

Automatically create and delete user
accounts in the application

4. Conditional Access

Secure access to this application with a
custamizable access policy
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2. Click Add user/group, search for the group (Example, VIP_Group), select it, and assign it to the
application.

» Users » Enterprise applications | All applications » ACME-ONE-SAML | Users and groups > Enterprise applications | All applications > ACME-ONE-SAML

ACME-ONE-SAML | Users and groups X

Enterprise Application

« -+ Add user/group | &7 Fdit as [i] Remove assignment @ Update credential () Refresh 8% Manage view
B Overview -
[ Deployment Plan (D) The application will appear for assigned users within My Apps. Set ‘visible to users?” to no in properties to prevent this

X Diagnose and solve problems

Assign users and groups to app-roles for your application here. To create new app-roles for this application, use the application registration
Manage

11l Properties [ First 200 shown, search all users & groups

Owr
e Display name Object type

Roles and administrators

S — No application assignments found

O B b R

Single sign-on

v

Provisioning

Application proxy

O m

Self-service

Custom security attributes

Security
% Conditional Access

i Permissions

3. Confirm the assignment, and the group will appear under the application’s Users and groups

tab.

> ACME-ONE-SAML | Users and groups > Enterprise applications | All applications > ACME-ONE-SAML | Users and groups >

Add Assignment - X

Diego Test Lab

Users and groups

Select a role
User
Users and groups X
@ Try changing or adding filters if you don't see what you're looking for. Selected (0)
2 Reset
Search
e No items selected

9 results found

Al

| Users  Groups

Name Type Details
Diego Test Lab Group DiegoTestLab@diegolabversaonmicrosoft«

vip User vip@diegolabversa.onmicrosoft.com

vIP User vip1@diegolabversa.onmicrosoft.com

3 Group for Answers in Viva Engag...  Group groupforanswersinvivaengagedonotdelete”

Group

4

11



) VERSA

Then click Assign, This ensures all members of the assigned group inherit SAML access to the appli-

cation without needing individual assignments.

+ 3 ACME-ONE-SAML | Users and groups > Enterprise applications | All applications > ACME-ONE-SAML | Users and groups
Add Assignment - ®

Diege Test Lab

b When you sssign a group to an spplicaton, only users divectly i the group will have access. The assignment
Goes not scade to nested Groups

Users and groups
1 group selected.
Select a role

Concerto configuration for ENTRA-ID SAML Authentication Profiles

Navigate to User and Device Authentication Profiles
Go to:
Configure > Security Service Edge > Users and Device Authentication > Profiles then “+ Add”

~ = . N Administrator
W VERSA ACME-ONE CONFIGURATION g';) America/Bogota = 8 Englsh v | @ g U o dministrator

Publish (1)

User and Device Authentication Profile

User and Device Authentication Profles (1) + Add & Refresh Select Columns ~
Name Type Description Tags Last Modified
> | AD Server_Acme One LDAP 712872025, 4:54:47 PM
Administrator
Showing1-1of Lresults 10 = Rows per Page Gotopage 1~ 1

Select SAML, Click Get Started
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Add User and Device Authentication Profile x
Select which user / device authentication profile you would like to configure.
©
LDAP SAML RADIUS
LDAP is a client-server protocol that enables a SAMLE for ovides
network device to access an LDAP server, which so that they can access multiple services and i before allowi
Y web them to access anetwork, a device, or related
attribute-based information. browser-based single sign-on (SSO). services.
Versa Directory User Certificate Based Device Certificate Based
vvvvv Cartit L Cartan k
of users and groups for authentication purposes, as tovalidate the identity of users. When you enable tovalidate the dentity of devices. When you enable
‘weell as add individual users and user groups.
initiat for usersto initiat t ient for users to
Note: Only ane Versa Directory authentication profil P ariicad portat L portal
Itac Conly on Ver=a Lirecary aurhentication peiile registration and gateway connection. registration and gateway connection.

canbe added.

Cancel Get Started

Select ENTRA-ID
To configure the settings, use the information collected in Step 8 from the Microsoft ENTRA ID. Go
to Entra ID > Enterprise apps > All applications > ACME-ONE-SAML > Single sign-on (SAML).

From this page, copy/download the values required :

e Certificate (Base64) — Download.

e Login URL — Copy.

e Microsoft Entra Identifier (Entity ID) — Copy.
e Logout URL - Copy.
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Home > App registrations > Enterprise applications | All applications > ACME-ONE-SAML >

ACME-ONE-SAML | SAML-based Sign-on - %

Enterprise Application

« T Upload metadata file 9 Change single sign-on mode  #= Test this application 27 Got feedback?

B Overview
[ Deployment Plan
e SAML Certificates

X Diagnose and salve problems

Manage Token signing certificate 2 dit
Status Active

m Properties Thumbprint 0382CE53329AACFO16A20F1C7419EBFOE150D786
Expiration 9/4/2028, 10:34:51 AM

&r Owners Notification Email diegochaves@diegolabversa.onmicrosoft.com

&, Roles and administrators App Federation Metadata Url \ https://login.microsoftonline.com/a08ab2d2-a5df-... [y

= . ICemf\cate (Base64) Download ||

sers and groups Certificate (Raw) Download

2 single sign-on Federation Metadata XML Download

@ Provisioning
Verification certificates (optional) £ kit

£ Application proxy Required No

€ Self-service Act\.ve 0
Expired 0

] Custom security attributes
Security (4] Set up ACME-ONE-SAML

@& Conditional Access . . .
You'll need to configure the application to link with Microsoft Entra ID.

P o

asw Permissions Login URL ‘ https://login.microsoftonline.com/a08ab2d2-a5df-... D|

@ Token encryption Microsoft Entra Identifier \ https://sts.windows.net/a08ab2d2-a5df-481b-9ffa... ﬁh|
Logout URL [ htps/oginmicrosoftonline.com/a08abad2-asdf-... [ |

Activity

3 Ssign-in logs v _

Single Sign-on URL, Service Provider Entity ID and Identity Provider Entity ID are mandatory

fields to be configured and you must upload certificate issued by Microsoft Entra ID.

Add SAML Authentication Profile

v O .
Select SAML Type
D)
okta WPingidentity. 1] Office 365 > o
OKTA Ping |dentity Office 365 Microsoft Entra D Goagle |AM Other
Single Sign-out URL.
Service Provider EntityID* 7 Service Provider Certificate
Select- *  + AddNew
Identity Provider Entity 1D* + Identity Provider Certificate ™
~Select = 4 AddNew
PrefixID Cache Exgiry Time (mins)
©
‘Group Attribute ‘Concurrent Logins

Reply URL [Assertion Consumer Reply URL)

. - N -

Complete the parameters using the values from the Microsoft Entra id

Example:
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Single Sign-on an out URL: https://login.microsoftonline.com/a08ab2d2-a5df-481b-9ffa-
bfb7a50a22c4/saml2

Service Provider Entity ID: https://acme-one-sasegwdiegos-lab.versanow.net/metadata

Identity Provider Issuer: https://sts.windows.net/a08ab2d2-a5df-481b-9ffa-bfb7a50a22c4/

Edit SAML Authentication Profile: ENTRA-ID-SAML

x
D
S
Select SAML Type
L]
okta WPingidenity. 1] Office 365 43 (o] =
OKTA Ping Identity Office 365 Microsoft EntraID Google LAM Clsco Duo Other
I Gt & Lk ] Single Sign-out URL
Service Provider Entity 1D~ » Service Provider Certificate.
| I | “seect- -+ AddNew
Identity Provider Entity 1D~ + Identity Provider Certificate ™
I~ ] P— ]+
==
Hame: ACME-ONE-SAML
P AV S
esued Te:
tssuad By
== ¢
Pref|D Cache Exgiry Time (mins) Cache Expiration Mode
P
Group Attribute Cookle Expiry Time imins) @ Concurrent Legins
" 1
o e
Then Upload the Identity Provider Certificate by clicking on the Add New button.
Add SAML Authentication Profile x

st Umindumoos Aebmasuek
Select SAML Type
3 L Y1 Y
okta MPing|dentity. 1] Office 365 > (o] =Uus
OKTA Ping Identity Office 365 Microsoft Entra 1D Google IAM Cisco Duo Other
Single Sign-on URL* Single Sign-cut URL
e F_acmeonesami_}
Service Provider Entity ID* » Service Provider Certificate:
hitps:iacme-ore-sasegwiliegos | 3b versanow ret/metadsta —Select— . 4 AddNew
Identity Provider Entity ID* Identity Provider Certificate *
R ——— e =
PrefuciD Cache Expiry Time (mins]
- 0
Group Attribute. Concurrent Logins
.
Reply URL {Assertion Consumer Reply URL)
*  hitpsfiac onsumer
‘Cancel
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Name to CA-Chain Name upload certificate issue by clicking on the Upload File.

Add Certificate/CA-Chain/Private Key

Certificate Type () CA Chain

Allowed file formats are .crt, .cer or .pem

CA-Chain Name =

ACME-ONE-SAML

I Upload File I

Then Add

Add Certificate/CA-Chain/Private Key

Certificate Type () CA Chain

Allowed file formats are .crt, .cer or .pem

CA-ChainName "

ACME-ONE-SAML

Upload File
ACME-ONE-SAMLcer %

If certificate was uploaded successful, the certificate details will be displayed

Edit SAML Authentication Profilo: ENTRA-ID-SAML %

Settngs nes e Groves R St

Select SAML Fype.
okta WPingidentity. 1] Office 365 (o] 2Us
OKTA. Ping Identity Offce 365 Gaoogle IAM Cisen Duo. Other
singesgronuRL* FR—
oo -
‘Service Provider Entity ID" + ‘Serviee Provider Certifcate
[ ———— souc: « A
dertity Provider Enty D° +
[ - Addhew
e s50Ceicate
104848 10 2028-09-03 104847
refein
w
GroupAtrb ook Bk Timeninl Concurrent Loghns
m B

Reply URL (Assertion Consumer Reply URL]

Then Next
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On the Users and User Groups page, you can add individual users or entire groups. Click User

Groups and add the VIPT_Group created in the Okta app. Click Add, then click Next to continue.

On the Review & Submit page, enter a Name and Description for the profile, then review all con-
figuration details including general information, SAML settings, and assigned users or groups. Once

confirmed, click Save to complete the profile creation.

Add SAML Authentication Profile

° ° ®
| —. S—.C

-

‘General

Name Description
.

g

Settings  # £t
. -
Singhe Sign-on URL. Vimdpi 71
e
Service Provider Entity ID hapsiacme-one-sanegwaliegos-lab varsanow net/met adits
‘Service Provider Certificate

F— B

Prefo D OKTA
st :
e :
Group Attribute

Reply URL (Assertion Corsumer Reply URL)

Users & User Groups ~ # ot

Usrs(o ‘Usar Groupat1)

o S

o v S

After creating and Publishin the Authentication Profile, you must apply them to the Secure Access Client policy to en-
force authentication and apply the corresponding security policies.

Navigate to:

Configure > Security Service Edge > Secure Access > Client-based Access > Rules.
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Click "+ Add" to create a new Secure Access Client rule or edit an existing rule.

In the Match Criteria configuration, navigate to the Users & Groups section. Under the Users &
Groups panel, click on Customize to begin specifying user-based access rules using the authentica-

tion profile you previously created.

@  /dministrator

W VERSA ACME-ONE CONFIGURATION \:) America/Bogota v = =8 English o e

Manitor

ind
Analytics

=

Edit Client-based Access Rule: Secure_Access Windows_Profile

Operating System Endpoint Posture Source Geo Location & Tratfic Action Gateways Clent Configuation Agant Profil From EIP Review &Configure
Source IP Address

By default we have chosen all users and groups to apply your security enforcements

1f you prefer, you can select the specific users or groups for the security posture.

Users & Groups ©

o
CC ¥ KnownUsers

2[==]

Ce ) =) s S

In the Users & Groups customization panel, select Selected Users as the user type. Then, under
Enable Rule for the following matched users or user groups, choose the appropriate authentica-

tion profile (Example., ENTRA-ID-SAML). This allows the policy to enforce access control based on

Active Directory user group membership.
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W VERSA ACME-ONE CONFIGURATION o) Arerica/Bogota ~ = % bnglsh | @) Administrstor

= Service Provider Administrator
Edit Client-based Access Rule: Secure_Access_Windows_Profile
View

By default we have chosen all users and groups to apply your security enforcements
B If you prefer; you can select the specific users or groups for the security posture.

Configure

« Back Users & Groups

UserType 1 | @ Selected Users| O Known Users

Enable Rule for the following matched users or user groups

2| enTrai-samL

Jser Group: Users

((vipi@diegoiabversa.onmicrosoft.com x ) Searchfor Users

Users (1)
User Name FirstName Last Name
B vieladiegolabrersa.onmicrosoft.com vipt vip

e ) ()

In this step, you can choose to add specific users or groups to enforce security policies. Use the User

Groups or Users tabs to select the desired entries.

. _ Administrator
W VERSA ACME-ONE CONFIGURATION ‘-“ﬁ AmericaBogota = W Englsh v | @ iUl rator

i Edit Client-based Access Rule: Secure_Access_Windows_Profile

By default we have chosen all users and groups to apply your security enforcements

If you prefer, you can select the specific users or groups for the security posture:

& Back Users & Groups
UserType  (®) SelectedUsers () KnownUsers

Enable Rule for the following matched users or user groups

ENTRAAD-SAML

'

(_vip1@diegoiabversa onmicrosoft.com

Users(1)

User Name First Name Last Name

@  vipl@diegolabversaonmicrosoft.com VIPL vIP

Cee ) o) e .

After reviewing all configuration sections, click Save to apply the settings to the current Secure Access Profile. Then go
to the Publish section at the top-right corner of the screen and click Publish.

Verification

When a user connects to the Gateway and SAML is enabled, the Gateway redirects the login to the configured IdP (Ex-
ample., Okta or Entra ID). After the user completes credentials/MFA, the IdP returns a signed SAML assertion to the
Gateway. The Gateway validates the signature and audience, extracts the NamelD and any mapped attributes (email,
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groups/roles), and—if successful—establishes the session and applies the matching Secure Access policy. Authentica-
tion events can be verified in Concerto under View > Dashboard > Secure Access > Users > Event, where successful
and failed attempts are logged with details such as username, tunnel IP, and applied profile.

1 . . Administrator !
W VERSA ACME-ONE VIEW D America/Bogota = W Engish @ | UL ator
a | ]
View

Summary  Usage Registry  LiveUsers

e Events per user Events per type
Tep L Top Lt
B
® diesvlsbidiescisbversanet @ i ® vinzade i @ ot @ deete @ falre
Events
Click taSet or Clear Fiter(s ©  Show 10 v Entries |jj
Receive Time ~_Appliance User Device RAC Access T RAC Event RACTunnel IP___RACIP VPN Profile Routing Instance Sechcc Rule Name
= =
Sep4th2025, 20445 PM-05  SaseGWiiegos-lab o 200R  ipsec ereate 19216822417 107310635 Secure Access Windows Profile  ACME-ONE-Enterprise | Secure_Access Windows_Pr

You would see the method used and the authenticated user in the Authentication Logs under View

> Dashboard > Secure Access > Logs > Authentication > Events.

Events Policies Charts

Authentication events

Click to Set or Clear Filter(s) € Show 10 ~ | Entries )|
Receive Time ~  Appliance Auth Profile Method Status  Status Message TimeTaken ~ User Source Address  Destination Address  SourcePort  Dest
@ Sep4th2075,2:04:18PM-05 SaseGWhiegos-lab Default-Auth-Profile  ENTRA-ID-SAML success  VSA:SAML: Authenticated successfully.  Oms vip2@diegolsbversa.cnmicrosoft.com  1073.106.35 107310618 59925 243

Additionally, administrators can confirm active sessions and mapped users via CLI commands on Sa-
seGateway typping command show orgs org-services <ORG-NAME> user-identification live-us-

ers list brief.
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admin@SaseGWD1egos-lab-cl1> show orgs org-services ACME-ONE

syn : incomplete path
[ 1[2025-09-04 12:11:46]
admin@SaseGWDiegos-lab-cli> show orgs org-services ACME-ONE user-identification live-users list brief
TIME
SESSION TO EXPIRATION
STATUS HITS EXPIRY MODE

vip2@diegolabversa.

[0k][2025-09-04 12:11:50]
admin@SaseGWDiegos-lab-cli>

Versa Directory

Versa Directory is a Versa-hosted IDP service based on LDAP, available for Versa-hosted SSE Services. The prerequisite
to use this service for you tenant is that enabled on Headend at infrasture level by Versa or MSP(if using thirdparty
hosted headend):

Now to use Versa Directory and create users refer the following document:

Device Certificate Authentication

Device certificate-based authentication strengthens enterprise security by validating not just user credentials but also
the identity of endpoint devices before granting access to corporate networks and applications. Unlike traditional
password-based mechanisms, this method leverages digital certificates issued by a trusted Certificate Authority (CA).
During authentication, the device must present a valid certificate that is signed by the trusted CA and has not expired
or been revoked. This ensures a strong CA trust relationship, guaranteeing that only devices with properly issued and
trusted certificates are allowed to connect.

Common Use Cases
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1. Corporate Laptops in BYOD Environments: Even in bring-your-own-device scenarios, only corporate-
issued laptops with valid certificates can establish VPN tunnels, enforcing Zero Trust by validating both

the user and the device.

2. Regulated Industries (Banking, Healthcare, Government): Compliance frameworks like PCI-DSS,
HIPAA, and GDPR mandate strong access controls. Device certificates provide tamper-resistant proof of

device identity, safeguarding sensitive systems against unauthorised access.

3. Remote Workforces with Layered Authentication: Users log in via SAML (e.g., Okta, Azure AD), while
their devices authenticate using certificates. This layered approach ensures stolen credentials alone can-

not grant access from untrusted devices.

4. Pre-Logon VPN for Domain Services: Certificates enable VPN connectivity before user login on Win-
dows/macOS, allowing Group Policies, scripts, and security updates from Active Directory to be applied

seamlessly at login.

Configuration Workflow

1. Step to Generate Device Certificate:

) VERSA

If you are using a self-signed certificate, follow the official guide in the documentation. You can find the detailed pro-

cedure under the section “Generate the CA Key, CA Certificate, and Device Certificate” in the following link:

https://docs.versa-networks.com/Security Service Edge (SSE)/Configuration from Concerto/Configure Certificate-

Based Device Authentication for Secure Access

If you are using a enterprise Certificate you would follow the next guide:

To validate possible link with Sudhir
2. Upload the CA Chain: Import the root and intermediate CA certificates that will be used to validate

client device certificates.

3. Configure Identity Mapping: Select the username identifying field from the certificate (e.g., CN, UPN,
or SAN).

4. Enable Validation: Optionally enable OCSP (Online Certificate Status Protocol) checks for real-time cer-

tificate revocation verification and selects the source VR for the query.

5. Pre-Logon Stage: Toggle the option to enable device certificate-based authentication during pre-logon

if required.
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6. Multi-Factor Support: When combining device certificate authentication with user-based authentica-

tion methods (e.g., SAML, LDAP), define the order of authentication to align with security policies.

7. Finalize: Assign a profile name and save the configuration.

Ensure the Root CA is uploaded to Gateways from Concerto and reflected correctly in the Device:

Navigate to Certificates Go to: Configure > Security Service Edge > Settings > Certificates then “+ Add"

L . — - . Administrator
W VERSA ACME-ONE CONFIGURATION :—l) America/Boota = ® English | @ g ico brovider Adrinistrator

~ User and Device Authentication

Below are all the Certificates

Rules
Profiles 4] + Add | & CxportRootCA & Refresh Select Columns. v
SCIM Integration iile. Tvpe Issued To Issued By Valid Expires Actions
RO > UserDefined Oblects
\CME-ONE.zip CACertificate  VOS Certificate Versa Concerto Certificate Autharity From: 7/22/2025, 9:51:35 AM 1825 days
sk 5GP Pecr Policies “A-Chain ACME-ONE To: 7/21/2030, 9:51:35 AM
Monitor SA=TRUE
Captive Portal
Certifeats oncerto_ca_chainpem CA-Chain Versa Concerto Certificate Authority  VersaNetworks Root Certificate Authority  From: 11/19/2021, 6:49:31AM  3600days ¢
ertmeates To: 9/28/2031, 7:4%:31 AM :
Files And Folders IKTA-ACME crt CA-Chain dev-45952259 dev-48952259 From: 8/8/2025, 12:23:19 PM 2652 days
To: 8/8/2035, 12:24:18 PM
LAN Interface

Inventory y .
Mobile Device Manager

SIEM Integration

i

Site-to-Site Tunnels
URL and IP Reputation Lookup

VPN Settings

In Add Certificate/CA-Chain/Private Key, select the Certificate Type you need:

o CA Chain, or Cert/Key bundle, or Private Key.

Add Certificate/CA-Chain/Private Key X

Certificate Type (® Cert/Keybundle (_) CAChain () Private Key

The file to be uploaded needs to be in .zip format. They will consist of 2 files: a key and a certificate. The key file needs to have .key extension. There is
no restriction on the extension of the certificate file.

Certificate Name *
CA-Chain Name*
Select v 4 Add
Pass-Phrase
®
Upload File
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As an Example, Add a CA Chain

CA-Chain Name: enter the name (Example, device-auth-ca-chain).

e Click Upload File and select the CA chain file.

e Click Add.

Add Certificate/CA-Chain/Private Key x

Certificate Type () Cert/Keybundle () CA Chain (_) Private Key

Allowed file formats are .crt, .cer or .pem

CA-Chain Name *

device-auth-ca-chain

Upload File

device-auth-ca-chain.crt %
——

Now check CA Chain (device-auth-ca-chain) is successfully uploaded and listed under Configure > Security Service
Edge > Settings > Certificates :

WVERSA  ACME-ONE CONFIGURATION ] America/Bogola i | % Engleh v | () | Administrator

Service Provider Administrator

« . e |

View
Below are all the Certificates
Configure Q. Search + Add & ExportRootCA & Refresh Select Columns. v
v Name File Type Issued To Issued By Valid Expires Actions
v Certificates
A CACertificate
ACME-ONE ACME-ONE.zip CA Certificate VOS Certificate Versa Concerto Certificate Authority From: 7/22/2025, 9:51:35 AM 1825 days
CA-Chain: ACME-ONE To: 7/21/2030, 9:51:35 AM
Monitor CA=TRUE
W CAChain
ACME-ONE concerto_ca_chain.pem CA-Chain Versa Concerto Certificate Authority Versa Networks Root Certificate Authority From: 11/19/2021, £:49:31 AM 3600 days

To: 9/26/2031, 7:49:31 AM

Analytics
device-auth-ca-chaincrt CA-Chain RAS-CA RAS-CA From: 5/21/2025, B:43:12 AM 3650 days H

To: 5/19/2035, 8:43:12 AM

=] OKTA-ACME OKTA-ACME crt CA-Chain dev-4B782259 dev-4B98225% From: B/8/2025, 12:23:1% PM 3652 days
To: 8/8/2035, 12:24:18 PM

Inventory
PrivateKey

Navigate to User and Device Authentication Configuration
Go to:
Configure > Security Service Edge > User and Device Authentication > Profiles then "+ Add”

) VERSA
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ACME-ONE

Sacure SD-WAN

Real-Time Protection
> Advanced Security
> Secure Access

> Digital Experience Monitoring (DEM)
> TLS Decryption

> Bandwidth Limits

> Profiles and Connectors

> Partner Integration

User and Device Authentication °

Rules
SCIM Integration
> User-Defined Objects

> Settings

CONFIGURATION

Type Description

LDAP

User Certificate

SAML

SAML

Administrator

j America/Bogota ~ =  HE English ~ )

e Service Provider Administrator

Publish (0]

& Refresh Select Columns

Tags Last Modified

8/28/2025, 10:24:08 AM
Administrator

9/13/2025, 11:54:01 AM
Administrator

9/4/2025, 2:01:18 PM
Administrator

8/8/2025, 4:51:03 PM
Administrator

Gotopage 1~

Select Device Certificate Based as Authentication Method then Click Get Started

Add User and Device Authentication Profile

Select which user / device authentication profile you would like to configure.

LDAP

LDAP is a client-server protocol that enables a
network device to access an LDAP server, which
provides directory services that store descriptive
attribute-based information.

Versa Directory

SAML

SAML is a common standard for authenticating users
s0 that they can access multiple services and
applications. SAML is most commonly used for web
browser-based single sign-on (SSO).

User Certificate Based

Certificate-based authentication is a secure method
to validate the identity of users. When you enable
certificate-based authentication, the gateway
initiates a request to the SASE client for users to
provide their certificates during client portal
registration and gateway connection.

RADIUS

RADIUS server provides an external database that
you can use to authenticate users before allowing
them to access a network, a device, or related
services.

Cancel Get Started

In Add Device Certificate Authentication Profile > Settings:

e Client CA Chain > Select the certificate you uploaded (Example device-auth-ca-chain.crt).

e Username Identifying Field in Certificate > choose the correct option (Example Subject com-

mon-name).

e Cache Expiry Time (mins) > 10, (Default Value).

e Cookie Expiry Time (mins) > 720, (Default Value).

Device Certificate Based

Certificate-based s hod
to validate the identity of devices. When you enable
certificate-based authentication, the gateway
initiates a request to the SASE client for users to
provide their certificates during client portal
registration and gateway connection.
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e Concurrent Logins > 1.

e Leave Verify with OCSP disabled (optional unless required).

Then Click Next to continue

Add Device Certificate Authentication Profile

@

Sattings Authentication Order Review & Submit
Client CA Chain®

Select: * % AddNew

Verify with OCSP
Enable server certificate verification using the Online

Certificate Status Protocol (OCSP).

Username Identifying Field In Certificate

Cache Expiry Time (mins) ()

10

Cache Expiration Mode
Cookie Expiry Time (mins) @

720

Concurrent Logins

1

Add Device Certificate Authentication Profile

Qllent CAChain

P— - e

Verify with OCSP

Meme:  device auth carchain

FileName:  device auth-carchainert

BT RASCA

bsuedBy:  RAS-CA

bty 20250521 08:43:12 t0 2035-05-19 08:43:12

Cache Expiry Time (mins) &

10

Cache Expiration Mede

Cookis Expiry Time (mins)

720

Concurrent Logins.

In Authentication Order, you can optionally enable Pre-login devices to authenticate before user login. If you do not
need this feature, leave it as Disabled.

Enable Device Authentication.

In the authentication order selection, you will see two options: Device Authentication or User Authentication. Choose
Device Authentication to ensure the device authenticates first.
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Add Device Certificate Authentication Profile

Austhanticstion Order Review & Submit

Prelogon Device Authentication

don tologinin

Prelogon Disabled

Device Authentication

Enable Devi credential

Device Authentication Disabled

Add Device Certificate Authentication Profile

°

Settings. Aathentication Order Redew & Submit

Prelogon Device Authentication
. .

Prelogon Disabled

Device Authentication
Enabie Device Authentication to suthenticate

Device Authentication Enabled

O User

Cancel Back

Then Click Next to continue

In the Review & Submit page:

Confirm the Client CA Chain = device-auth-ca-chain.
Confirm Username Identifying Field = subject.
Verify Authentication Order = Device.

Click Save then Publish.
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Add Device Certificate Authentication Profile .

Bevieur your configurations. Before s britting redew and edit any steps of your condgurationbelow

Dasciption

Settings  ~ Edit
Client CAChain. dedce-athca-chain
Usermame dentitying i n Certfcats st
e ——— Distled
15 CA Server o nterret?
VP Name: ACME-ONE Enterprise:
‘cache Exiry Thee i) 0
Cache Expiration Mode
ConarrentLogie 1
Cookia Expiry Tima (mirs)
7

Authentication Order  / £t

Pralogon Disstled
Profi to stherticate first Oedor

Installing Certificates on the Client Device:

Download the certificate file onto the client machine (for example, the .pfx file signed by the same

CA authority used for the CA chain upload in the previous section)

For Windows open the Run dialog, type mmc, and press Enter.

[Cg] Type the name of a program, folder, document. or
Internet resource, and Windows will open it for you.

Open: | R

oK Cancel Browse...

In the MMC console, go to File — Add/Remove Snap-in.
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@ Console1 - [Console Root] = o X
Amun View Favorites Window Help - & X
New Ctrl+N

Open.. Ctrl+0 Actions

Save Ctrl+S
There are no items to show in this view. W

Save As..
More Actions »

Add/Remove Sna Ctrl+M

Options..

Tl +

1wf

2services

Exit

Enables you to add snap-ins to or remove them from the snap-in conscle.

Select Certificates, click Add, and choose Computer Account to manage device-level certifi-

cates.

- Add or Remove Snap-ins X
E Consolet

) | You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For extensible snap-ins,
ﬁ, File  Acti you can configure which extensions are enabled.

L Al

| ConsoleR| Available snap-ins: Selected snap-ins:
Snap-in Vendor B8 ConsoleR.. Edit Extensions...
= ActiveX Control Microsoft Co.. Remove
izati an.. Microsoft Co..

| Microsoft Co...
¥~ Component Services Microsoft Co.. Move Up
@ Computer Manage.. Microsoft Co...
f.ﬂ; Device Manager Microsoft Co... Add’> Move Down
w= Disk Management  Microsoft an...
{3] Event Viewer Microsoft Co...
[ Folder Microsoft Co..
|=[ Group Policy Objec..  Microsoft Co..
zS IP Security Monitor  Microsoft Co...
'\S IP Security Policy M..  Microsoft Co...
1] Link to Web Address  Microsoft Co..
& Local Users and Gro... Microsoft Co.. Advanced..

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

Cancel -
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Al R < i ><
Certificates snap-in 574
Lcted set of snap-ins. For extensible snap-ins,
) This snap-in will always manage certificates for:
() My user account
[ :
I Edit Extensions..
© Computer account
Remove
Move Up
Move Down
< Back Next > Cancel
® [ ocal Users and Gro.. Microsoft Co... Advanced..
Description:
The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.
OK Cancel

Choose Local Computer and Finish.

Select Computer X

Select the computer you want this snap-in to manage.
This snap-in will always manage:

© Local computer: (the computer this console is running on)

() Another computer: B

[ ] Allow the selected computer to be changed when launching from the command line. This
only applies if you save the console.

< Back Finish Cancel
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Then OK.

Add or Remove Snap-ins X

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For extensible snap-ins,
you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-in Vendor " Console Root Edit Extensions...
=1 ActiveX Control Microsoft Co... L Certificates (Local Computer) Remove
Authorization Man.. Mierosoft Co...
. Certificates Microsoft Co...
CR Component Services Microsoft Co.. Move Up
& Computer Manage.. Microsoft Co..
Ll. Device Manager Microsoft Co.. Add > Move Down
w Disk Management  Microsoft an...
{3 Event Viewer Microsoft Co...
[l Folder Microsoft Co..
'=[ Group Policy Objec.. Microsoft Co..
.S IP Security Monitor  Microsoft Co..
&, 1P Security Policy M..  Microsoft Co..
= Link to Web Address Microsoft Co..
& ocal Users and Gro.. Microsoft Co... Advanced..

Description:

Right-click on the Certificates folder under Personal.

E Console1 - [Console Root\Certificates (Local Computer)\Personal\Certificates] = O X

File Action View Favorites Window Help - &8 x
o 250 =

N ertificates (L0 al Compt Issued To - Issued By Expiration Date  Intendec| | Actions
5

|| Trusted Root Certifice More Actions »
[ Enterprise Trust

[ Intermediate Certificc
] Trusted Publishers
] Untrusted Certificate:
|| Third-Party Root Cert
[ Trusted People

[ Client Authentication
[ Preview Build Roots
[ Test Roots

[ AAD Token Issuer

[ Avast Mail Scanner Tr
[ ] Avast SSL Scanner Ca
(] eSIM Certification Au
|| OEM eSIM Certificatic
(] Passpoint Trusted Ro-
[ Remote Desktop

[ Certificate Enrollmen
[ Smart Card Trusted R
7 Trusted Packaned Ani

B Y B N N Y
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go to More Actions then All Tasks > Import.

E Console1 - [Console Root\Certificates (Local Computer)\Personal\Certificates] = o X
@& File Adion View Favorites Window Help

s 2™ 0|6z HE

A~ ]
v 5 Certificates (Local CompL Issued To Issued By Expiration Date  Intendec | Actions
i Rooroi e Nt bt anss e
| Certificates

> [ Trusted Root Certificz Request New Certificate...

- & x

>
“ Enterprise Trust . 5
7 Intermediate Certifice iew

Trusted Publishers Advanced Operations > New Window from Here
Untrusted Certificate:
Third-Party Root Cert New Taskpad View...
Trusted People

Refresh
Client Authentication
rt List..
> | Preview Build Roots Export List
> [ Test Roots .

AAD Token Issuer
L] Avast Mail Scanner Tr
" Avast SSL Scanner Ca
7] eSIM Certification Au
OEM eSIM Certificatic
» (2] Passpoint Trusted Ro
Remote Desktop
Certificate Enrolimen
Smart Card Trusted R
Trirctad Packanad Ani

Contains actions that can be performed on the item.

The Certificate Import Wizard will open. Ensure Local Machine is selected as the store location,

then click Next.
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¥ Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation lists
from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity and
contains information used to protect data or to establish secure network connections. A
certificate store is the system area where certificates are kept.

Store Location

Current User

Local Machine

To continue, click Next.

Next Cancel

Browse to the location of the certificate file (for example user1-cert.pfx), select it, and click

Open

) VERSA
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& &# Certificate Import Wizard

File to Import
Specify the file you want to import.

I C:\Users\admin\Desktop\user1-cert.pfx Browse... I

Note: More than one certificate can be stored in a single file in the following formats:

Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P7B)

Microsoft Serialized Certificate Store (.SST)

Next Cancel

Enter the certificate’s private key password.

o Optionally, you may check Mark this key as exportable if you want to re-use it later.
o Ensure Include all extended properties is checked.

Click Next.
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& L* Certificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password.

Type the password for the private key.

Password:

(| Display Password

Import options:

Enable strong private key protection. You will be prompted every time the private
key is used by an application if you enable this option.

:] Mark this key as exportable. This will allow you to back up or transport your keys
ata later time.

Protect private key using virtualized-based security(Non-exportable)

@ Include all extended properties.

conce

On the Certificate Store screen, select Place all certificates in the following store, ensure

it is set to Personal, and click Next.
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& L¥ Certificate Import Wizard

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate

© Place all certificates in the following store
Certificate store:

Personal Browse...

cance

Click Finish to complete the import. A confirmation message should appear:

“The import was successful.”
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Completing the Certificate Import Wizard

The certificate will be imported after you click Finish.

You have specified the following settings:

Certificate Store Selected by User  Personal
Content PFX
File Name C:\Users\admin\Desktop\user1-cert.pfx

Verify that the imported certificate is

Certificates (Local Computer) > Personal > Certificates.

Cancel

visible

) VERSA

under:
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ﬁ Console1 - [Console Roof\Certificates (Local Computer)\Personal\Certificates] = (] X
File Action View Favorites Window Help -8 x
= 7 B 6B
v Ll Certificates (Local Comp Issued To h Issued By Expiration Date  Intendec|| Actions
i _P;lrs:n:-lf. T Jlocalhost Versa Networks Localhost CA 7/12/2035 Server Al | Certificates 4
ertificates
[ Trusted Root Certifice ‘zﬂuseﬂ et RAS-CA 3/25/2033 Client A More Actions »

[ Enterprise Trust

[ Intermediate Certifice
[ Trusted Publishers

[ ] Untrusted Certificate:
[] Third-Party Root Cert
[ Trusted People

[ Client Authentication
|| Preview Build Roots
|| Test Roots

[ ] AAD Token lssuer

[ ] Avast Mail Scanner Tr
[ ] Avast SSL Scanner Ca.
(] eSIM Certification Au
(] OEM eSIM Certificatic
[ Passpoint Trusted Ro
[ Remote Desktop

[ Certificate Enrollmen
|| Smart Card Trusted R.
" Tructod Parkansd Ani

VYV OV VY VYV VY VYV VYV VY VYV VYV VY VYV

Next, ensure the user has access to the private keys assigned at the device level. Click on the particular

device certificate > More Actions > All Tasks > Manage Private Keys.

ﬁ Console1 - [Console Root\Certificates (Local Computer)\Personal\Certificates] = [m] X
@& Ffile Action View Favorites Window Help - & x
o9 M@ K6 XE BE

v f‘jcenrﬁcatesanaTCOmpti Issued To ? esued By Expiration Date  Intendeq | Actions

~ 1 Personal
| Certificates

“1 Trusted Root Certifice
Enterprise Trust
Intermediate Certifice
> 21 Trusted Publishers
> [ Untrusted Certificate:
| Third-Party Root Cert Spen
Trusted People
> (2] Client Authentication
> (] Preview Build Roots

> 1 Test Roots Manage Private Keys..

> (1 AAD Token Issuer
| Advanced Operati >
_| Avast Mail Scanner Tr van perations

Avast SSL Scanner Ca
eSIM Certification Au
OEM eSIM Certificatic
> [ Passpoint Trusted Ro
> (2] Remote Desktop

» (7] Certificate Enrolimen
> (2] Smart Card Trusted R
5 7 Tricted Packanad Ant

2 localhost Versa Networks Localhost CA 7/12/2035

More Actions

Request Certificate with New Key...
Renew Certificate with New Key...

Export_

View or change the access security settings for the certificate's private keys.

Assign permissions for users.
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B Cancalas & Lo Rant\ Cartificatac [ acal tanD T ificates] . o %
— =0 Permissions for user1-cert private keys X
-8 x
4 Securty
Grol I
M SPEE e Issued By Expiration Date  Intendec | Actions
B8 sysTEM
. . Versa Networks Localhost CA 7/12/2035 Server Al w “ -
S8 Administrators (DESKTOP-PUC20LR\Administrators) .
B2 LogonSessionld_0_72735805 (NT AUTHORITY) RAS-CA 3/25/2033 Client AL More Actions »
e ———
More Actions »
Add Remove
Permissions for SYSTEM Allow Deny
Full control a O
Read . D
Special permissions
For special permissions or advanced settings,
click Advanced. Advanced
OK Cancel Apply

> [ Smart Card Trusted R
5 [ Triictad Packanad Ani

Verification

When a user connects to the Gateway and the Device Certificate Authentication profile is enabled,
the authentication order is processed as Device first, followed by User (SSO/LDAP). The user would
be prompted with a certificate selection pop-up to choose the correct device certificate. On subse-
quent connections, the same certificate would be auto-selected as long as no other device certifi-
cate is installed on the endpoint; if another device certificate is present, the client would prompt

for selection again.

If the certificate validation succeeds, the connection proceeds to the next stage where the user is
authenticated through SAML/SSO (or LDAP, depending on configuration), This ensures that both

the device and the user identity are verified before access is granted.
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¥ SASE Client = X

user2-cert
RAS-CA
Valid From: 7/16/2025 4:18:55 PM to 5/20/2033 4:18:55 PM

user1-cert
RAS-CA
Valid From: 5/21/2025 11:13:07 AM to 3/25/2033 11:13:07 AM
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User Certificate

User Certificate Authentication enhances enterprise security by validating the identity of individual users through
digital certificates issued by a trusted Certificate Authority (CA). Unlike device certificates, which identify and authenti-
cate endpoint hardware, user certificates are bound to a specific user identity and installed within their personal pro-
file.

Client certificate authentication from end devices relies on digital certificates to authenticate both users and systems
before granting access to the gateway, in addition to existing SAML or LDAP authentication mechanisms. In user cer-
tificate authentication, the focus is on verifying individual users across the same device, using a unique certificate con-
figured within each user’s profile. This method is particularly valuable in shared-device environments, as it prevents
user spoofing by ensuring that the Common Name (CN) in the certificate matches the username defined in LDAP or
SAML.

During authentication, the system validates that the presented certificate is signed by a trusted CA, has not expired or
been revoked, and that its CN or Subject Alternative Name (SAN) aligns with the username provided during login. This
process provides a secure, certificate-driven layer of identity verification that complements existing SSO and directory-
based authentication mechanisms.

Common Use Cases

1. Shared Workstations or Multi-User Systems:
In environments where multiple users share the same endpoint (for example, kiosks, customer-ser-
vice terminals, or lab systems), user certificates ensure that each session is authenticated to the
correct individual.
The system verifies that the Common Name (CN) in the certificate matches the username provided

in SAML or LDAP, preventing user spoofing and enforcing accountability for every login.
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2. Regulated Industries (Banking, Healthcare, Government):
Compliance frameworks like PCI-DSS, HIPAA, and GDPR mandate strong access controls.
User certificates provide identity-bound proof of authentication, ensuring that each login is cryp-

tographically linked to a verified individual, reducing the risk of credential misuse or impersonation.

3. Remote Workforces with Layered Authentication:
Users authenticate through SAML (e.g., Okta, Azure AD), while their certificates validate their per-
sonal identity at the gateway. This layered approach enforces Zero Trust principles by ensuring that

both the user credentials and the associated certificate match before access is granted.
4. Dual Validation with Device Certificates:

User and device certificates can be combined for layered authentication. The device certificate confirms
the integrity and trust level of the hardware, while the user certificate validates the person operating it.
This two-tier validation ensures that both the endpoint and the user meet the organization’s access con-
trol requirements.

The steps to configure are like the device certificate (Refer to the section before this one). We also have the option to
use the LDAP/SAML profile in conjunction with user certificate authentication.

Navigate to User and Device Authentication Configuration
Go to:
Configure > Security Service Edge > User and Device Authentication > Profiles then “+ Add"

- Ad tratos
W VERSA ACME-ONE CONFIGURATION ) Avericaiogota = W ngien v Q) pamneler
Real-Time Protection

) (5] @ Retresn SecCoums v
.

Advanced Security

Secure Access

Digital Experience Monitoring (DEM)
TLS Decryption

Bandwidth Limits

Profiles and Connectors

Partner Integration

Rules

=0

SCIM Integration

User-Defined Objects

Settings

Select User Certificate Based as Authentication Method then Click Get Started
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Add User and Device Authentication Profile

Select which user / device authentication profile you would like to configure.

LDAP

LDAP is aclient-server protocol that enables a
network device to access an LDAP server, which

SAML

SAML is a common standard for authenticating users
50 that they can access multiple services and

pr irectory services that store
attribute-based information.

Versa Directory

With Versa directory authentication, you upload lists
of users and groups for authentication purposes, as
well as add individual users and user groups.

Note: Only one Versa Directory authentication profile
can be added.

SAMLis most commonly used for web
browser-based single sign-on (SSO).

User Certificate Based

Certificate-based authentication is a secure method
tovalidate the identity of users. When you enable
certificate-based authentication, the gateway
initiates a request to the SASE client for users to
provide their certificates during client portal
registration and gateway connection.

RADIUS

RADIUS server provides an external database that
you can use to authenticate users before allowing
them to access anetwork, a device, or related
services.

Device Certificate Based

Certificate-based authentication is a secure method
to validate the identity of devices. When you enable
certificate-based authentication, the gateway
initiates a request to the SASE client for users to
provide their certificates during client portal
registration and gateway connection.

) VERSA

In Add User Certificate Authentication Profile > Settings:

Client CA Chain > Select the certificate you uploaded (Example ROOT-ACME-ONE.crt).

e Username ldentifying Field in Certificate > choose the correct option (Example Subject com-

mon-name).

e Cache Expiry Time (mins) > 10, (Default Value).

e Cookie Expiry Time (mins) > 720, (Default Value).

e Concurrent Logins > 1.

e Leave Verify with OCSP disabled (optional unless required).

Then Click Next to continue
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Add User Certificate Authentication Profile

Settings Additional Authentication Users Review & Submit
Method

Client CA Chain®
~Select— *  + AddNew
Verify with OCSP

Enable server certificate verification using the Online
Certificate Status Protocol (OCSP)

Username Identifying Field in Certificate *

Subject common-name

Cache Expiry Time (mins) @)

10

Cache Expiration Made

Cookie Expiry Time (mins) ()

720

Concurrent Logins

1

Add User Certificate Authentication Profile

©

Settings Additional Authentication Users. Review & Submit
Mathod
Client CAChain*
ROOT-ACME-ONE - Add New
Verify with OCSP
Details Enable server certificate verification using the Online
Name: ROOT-ACME-ONE Certificate Status Protocol [OCSP)
FlleName:  root-acme-one.pem

lssuedTo:  root-acme-one-cert.

lsuedBy:  root-acme-one-cert

Vaiidity:  2025-09-1208:32:18 to 2035-09-1008:32:18
Username Identifying Field in Certificate ~

Subject commenr-name

Cache Expiry Time (mins)

10

Cache Expiration Mode

Cookie Expiry Time (mins) ()

720

Cancel Skip to Review Next

In Additional Authentication Method, you can enable Multi-factor Authentication. If left Disabled, only the user
certificate is used for authentication.

When Multi-factor Authentication is enabled, you can select an additional method such as LDAP or SAML, and the
associated profile will be displayed.

Then, under Select which profile would you like to authenticate first? You can choose either the LDAP Profile or the
User Certificate Based Profile.
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Add User Certificate Authentication Profile ®
Settings Additional Authentication Users Review & Submit
Method
By enabling multi-factor ication, you can includ dditional icati such as LDAP, SAML, RADIUS and Veersa Directory.

Multi-factor Authentication Disabled

Add User Certificate Authentication Profile x

o @

Settings Additional Authentication Users Review & Submit
Method

By enabling multi-factor authentication, you can include an additional authentication method such as LDAP, SAML, RADIUS and Versa Directory.

' @) Muiti-factor Authentication Enabled

Below are your available options:

(® LDAP ) SAML

LDAP Profile available: AD_Server_Acme_One

Select which profile would you like to authenticate first?

) LDAP Profile (®) User Certificate Based Profile

Cancel Back Skip to Review [ hee |

Then click Next to continue.

In the Users step, you have the option to upload or manually add user entries. This is not mandatory and is only re-
quired if you explicitly want to match certificates to specific users.

e You can upload a user list in CSV format using the fields: UserName, First Name, and Last

Name.
e Alternatively, you can manually add a user by providing the same details.

If no users are added, the authentication profile will still work without explicit user-to-certificate mapping.
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Then Click Next to continue

In the Review & Submit page: you can provide a Name and an optional Description for the profile. Use
these fields to clearly identify the purpose of the configuration.

Confirm the Client CA Chain = device-auth-ca-chain.
Confirm Username Ildentifying Field = subject.
Verify Additional Authentication Method.

Click Save then Publish.

Add User Certificate Authentication Profile

Samings [rrrepe— [ R St
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Settings et
Clent CA Chain ROOTACME-ONE
Username identiting Fied n Certifeate st
Wity with OCSP Dissbled
s CA Serves e Intemet?
PN Name ACME CNE-EnterDrise
Cache Expiry Time mirs] w
Cache Expiration e

Concurrent Logins 1

‘Coskie Exgiry Time (i)
720

Additional Authentication Method . Ediit

Mt factor Authestication Erabied
Prafile o authenticate frst LDAP Profile:

Cache Expiry Time (mirs] ©

Add Device Certificate Authentication Profile

io
(<]

et ary ez
General

D s

Settings . Edit

Cllent CAChain devdce-athvia-chain
Username dentityng Fiek n Certificate: sublect
Vesify with OCSF Disatled
s CAServer oninternet?
VPN ACME ONE Enterprise
Cache Expiry Time (mina) b
Cache ExpirationMode.
Cancurrent Logins 1
Cookia Expiry Tima (wing)
720

Authentication Order  / £t

Pralogon Disstled
Profi to stherticate first Oedor

— -

Additional Requirements for Client Certificate Authentication
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Concerto generates a unique hostname for each SASE Gateway, which is referenced in the cert-auth-profiles.

admin@SaseGWD1iegos-lab-cli(config)% show orgs org-services ACME-ONE user-identification cert-auth-profiles
User_Certificate_acme-one {

server-hostname acme-one-sasegwdiegos-lab-cert.versanow.net;

server-addresses [ I

server-port 443;

routing-instance [ ACME-ONE-Enterprise Internet2-Transport-VR MPLS-Transport-VR ];

client-ca-chain ACME-ONE;

server-certificate SaseGWDiegos-lab.crt;

username-field subject;

}
[ok][2025-10-14 10:39:33]

Ensure this hostname resolves correctly to the corresponding Gateway IP address from the end user’s PC or
endpoint.
Verify that the same End-Entity Certificate used for client authentication is also configured on the server side

under the server-certificate field to maintain a valid certificate trust relationship.

Mandatory Requirement: The User Certificate Authentication Profile cannot be mapped directly to a Secure
Access Rule. It must be assigned as the Default Authentication Profile under Configure > Security Service
Edge > Secure Access > Client-based Access > Settings, as illustrated below. This configuration ensures

that user certificate validation is applied globally for all client-based access sessions.

[ ttings
o

)

e Default Authentication Profile Additional Settings

Select th

fault authentication
Access dl ased on the tenant’s
multiple email domains, you can spe
based on a client's email domain.

toapply toatenant’s Secure Client
ail domain. In addition, if a tenant has
adifferent authentication profile to apply

Default Authentication Profile

o ( User_Certificate_acme-one x_]

Define Authentication for Specific Domains (Optional)

Domains Authentication Profile

N —
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Installing Certificates on the Client Device:

The installation process for user certificates on client devices follows the same procedure described in the Device Cer-
tificate Authentication section. The certificate must be imported into the appropriate certificate store on the client
machine.

Verification

When a user connects to the Gateway and the User Certificate Authentication profile is enabled, the au-
thentication process begins by validating the user’s digital certificate before proceeding to directory-based
authentication (SAML or LDAP). The client prompts the user with a certificate selection pop-up to choose the

appropriate user certificate from their local certificate store.

During the first connection, the user must manually select the correct certificate corresponding to their iden-
tity. This selection prompt appears only when multiple certificates issued by the same Certificate Authority
(CA) are present on the endpoint. In such cases, the user is required to choose the appropriate certificate that
matches their user identity to ensure proper validation. For subsequent sessions, the same certificate is auto-

matically selected as long as no new user certificates from the same CA are added to the device.

If the certificate validation is successful, the authentication continues to the next stage, where the user’s cre-
dentials are verified through SAML/SSO or LDAP, depending on the configured profile. This sequence ensures
that the user identity is validated cryptographically before directory authentication occurs, providing a layered

and secure login process.
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SeLunus.
SeLunUS

¥ VERSA

W  SASE Security

Select a certificate for authentication
Site demo-acme- iegos-lab-c
Authentication successful...
vip5@diegolabversa.onmicrosoft.com

ROOT-ACME
Valid From: 10/14/2025 to 8/18/2033

diego-lab@diegolab-versa.net
ROOT-ACME
Valid From: 9/13/2025 to 7/18/2033

¥ SASE Client — X

W VERSA

demo-acme-one.versanow.net

Appendix A: LDAP

How to Find Base DN and Bind DN in Active Directory for Versa Integration
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Summary

When configuring Versa Security to integrate with Microsoft Active Directory (AD) using LDAP, you need to provide:
1. Base DN — the starting point in the AD hierarchy where searches begin.
2. Bind DN — the service account distinguished name (DN) Versa uses to query and authenticate against AD.

This article explains how to locate both values and provides ready-to-use examples.
Procedure

Step 1: Find the Base DN
The Base DN is derived from your AD domain.

1. Open Active Directory Users and Computers (ADUC).
2. Identify the domain name (e.g., versanetworks.com).
3. Convert the domain name into DN format:

DC=versanetworks,DC=com

Tip: The Base DN can be scoped to a specific OU if you want to restrict searches. Example:
OU=Engineering,DC=versanetworks,DC=com

Step 2: Find the Bind DN
The Bind DN corresponds to the account Versa will use for authentication and directory searches.

To retrieve it:

Command Line (dsquery):
dsquery user -name test1

Example output:
CN=test1,0U=0Utest2,0U=0Utest,DC=versanetworks,DC=com

Step 3: Understand CN vs OU
- CN (Container): Default AD containers, e.g. CN=Users.
- OU (Organizational Unit): Custom organizational units, e.g. OU=0Utest2.

Examples

Scenario DN Example Notes
Bas.e DN - Do- DC=versanetworks,DC=com Search starts at the
main Root domain root.
Bind DN - Ad- Service account lo-
min in Users CN=admin,CN=Users,DC=versanetworks,DC=com cated in the built-in
container Users container.
Bind DN - User | CN=test1,0U=0Utest2,0U=0Utest,DC=versanet- User object I_oca.te.d "
. OUtest2, which is in-
in nested OUs works,DC=com .

side OUtest.

Quick Reference
Use the following commands and templates to retrieve and configure LDAP DN values quickly.
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1. Find Base DN (Domain Root)

e Command (run on AD server):
dsquery * domainroot -scope base

e Output Example:
DC=versanetworks,DC=com

e Configure in Versa:
Base DN = DC=versanetworks,DC=com

2. Find a User’s Bind DN

e Command (example for user test1):
dsquery user -name test1

e Output Example:
CN=test1,0U=0Utest2,0U=0Utest,DC=versanetworks,DC=com

e Configure in Versa:
Bind DN = CN=test1,0U=0Utest2,0U=0Utest,DC=versanetworks,DC=com

3. Find an Admin Account in Users Container

e Command (example for admin):
dsquery user -name admin

e Output Example:
CN=admin,CN=Users,DC=versanetworks,DC=com

e Configure in Versa:
Bind DN = CN=admin,CN=Users,DC=versanetworks,DC=com

H

. Find OU-Specific Base DN

e Command (example for OU "Engineering”):
dsquery ou -name Engineering

e Output Example:
OU=Engineering,DC=versanetworks,DC=com

e Configure in Versa:
Base DN = OU=Engineering,DC=versanetworks,DC=com
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About Versa

Versa, the global leader in SASE, enables organizations to create self-protecting networks that radically
simplify and automate their network and security infrastructure. Powered by Al, the VersaONE Universal
SASE Platform delivers converged SSE, SD-WAN, and SD-LAN solutions that protect data and defend
against cyberthreats while delivering a superior digital experience. Thousands of customers globally, with
hundreds of thousands of sites and millions of users, trust Versa with their mission critical networks and
security. Versa is privately held and funded by investors such as Sequoia Capital, Mayfield, and BlackRock.
For more information, visit https://www.versa-networks.com and follow Versa on LinkedIn and X (Twit-
ter) @versanetworks.

83


https://versa-networks.com/platform/
https://versa-networks.com/platform/
https://www.versa-networks.com/
https://www.linkedin.com/company/versa-networks
https://twitter.com/versanetworks

